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Introduction 
 

Disaster recovery plans fall into two basic groupings – theoretical plans where the “best guess” as to the 
approach, recovery times, and success levels is given and accepted as a general risk measure by the 
stakeholders in the plan.  This is pretty much like predicting the weather – it will be right about 60% of the 
time, but the 40% that is wrong will invariable concern those systems or functionalities that the company 
simply cannot live without. 

The second type of plan is one not only accurate for the environment, but which is based on measurable, 
testable, and proven successful methods.  It is this latter category that the plan you are reading falls into.  It 
can be tested repeatedly in a lab setting to validate success ratios, it can be performed by the most 
unseasoned personnel in any organization, and it can be repeated across multiple environments with the 
results being the same. 

In summary, this plan is: 

1) Proven through repeated testing 

2) Reliable and simple to implement 

3) Application-specific covering: 

a. Microsoft Active Directory and IP Services  

b. Microsoft Exchange Services 

c. Microsoft IIS Web Services 

d. Microsoft SQL Server 

e. Peoplesoft Database on Microsoft SQL Server 

If you have other applications, then reading through this guide will give you a model for the steps to use in 
recovering any application.  The steps for recovering the CommVault software and VMware systems will remain 
the same regardless of the applications being used. 

Anything that you take from this guide will put you that much further ahead of the storm in terms of predicting 
your ability to recover from total disaster.  

 

How to Use this “Best Practices” Document 

This document highlights how combining CommVault’s speed to recovery with the VMware virtual disk 
simplicity you can find dramatic improvement in DR times and outcomes as compared with other technologies. 

Why CommVault:  CommVault provides this plan document as a means to understand, plan and carry out 
disaster recovery using CommVault QiNetix unified data management software.  There are MANY products that 
can backup and restore data, but CommVault’s unique system of indexing and simple and small database 
configuration give CommVault a large advantage in terms of speed to recovery over competing products.  
Instead of requiring many hours or even days to recover the backup environment prior to being able to being 
data restore, the CommVault environment can be recovered and begin restoration of data in as little as 90 
minutes with proper planning.   

The other dramatic advantage of the CommVault/VMware match-up is that neither of them are hardware 
dependent – as momma always said, “DR sites are like a box of Chocolates, you never know what you’re gonna 
get.”  With CommVault’s unique hardware agnostic view of storage and systems, and VMware’s ability to 
virtualize any platform to a common hardware appearance it does not matter what you have on hand, you can 
recover. 

To make this document work for you, start by reading it through and identifying those areas that the document 
describes as needing you to flesh it out.  Once you have identified the things you need to address, review the 
checklists and make your own custom versions of the information.  Then, safeguard the documents to make 
them easy and possible to retrieve in a disaster.  Do not store these documents in only one location – take 
them off-site along with your data where they can be retrieved following a site disaster. 
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Review your plans frequently.  The plan – and the associated documents – should be tested frequently.  The 
plan should be a living plan, which adjusts along with your business.   

 

Important Version Information 

The steps that are presented here have been tested successfully and are validated against version 5.9 SP3 of 
the Galaxy product.  Except for possible button locations and screen changes, the general steps listed here 
should be the same for any galaxy environment from 5.9 forward, 

Most all system steps here are applicable to Windows 2000, but testing was carried out using Windows 2003 
both with and without SP1.  As with the CommVault versioning, this should effectively work for any Windows 
version with possible button/screen location changes. 

The Exchange recovery here is for Exchange 2000 server, but would be applicable in part to Exchange 2003.  
There are differences in architecture, but mostly the steps would remain the same. 

The ESX server version represented here is tested on Version 2.5 of ESX server.  The steps should have a 
similar process in ESX 3 Server, but there may be differences.  Access to the new ESX server was not available 
at the time of the writing and so the steps could not be compared.  They will be addressed in a future revision. 

All other versions are noted where applicable and the reader should take care to include any SP 
levels/Versions/patches in their documentation and to validate their own plan against whatever versions they 
have. 

 

Pre-Planning 

This document, like so many others, is based on certain assumptions about your preparedness for a disaster.  
The steps in this plan have two very basic and very important assumptions: 

1) You are running both CommVault and VMWare in your environment and have the available licenses, 
features, and capabilities to perform the prerequisites needed to accomplish the steps in this guide 

2) You have some idea of your DR needs, the ability to customize and keep up-to-date the information 
that follows into a plan for your environment, and the ability to follow the pre-requisite checklist in 
order to prepare for the day when the plan is needed 

If you have those two key things, you are ready to proceed.   

 

Checklists to be able to use this plan pretty much as is 

To follow this plan you will need to be able to mark off everything on the following checklist.  Failure to 
maintain this checklist at the proper intervals (quarterly at a minimum, monthly is better) means that you will 
be able to recover but you will need significant knowledge and ability.  Maintenance of this checklist is the key 
to making your DR “idiot proof”. 

DR Preparation Checklist 1 – Business Objectives 

This checklist needs to be reviewed annually at a minimum to ensure that it is correct and that the plan is 
updated accordingly: 

1) Critical DR systems have been identified and approved by management? 

2) DR systems have been documented and safeguarded for easy retrieval, for the following settings: 

a. Service accounts and passwords 

b. Applications installed 

c. Dependent systems (ie – SQL DB’s or other application systems) 

d. SME contacts 
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3) DR SLA levels have been ID’d to management and above to ensure that priority servers get priority 
treatment in the event of DR. 

4) DR Priority list is documented in the checklists section of the DR doc 

5) DR Doc is reviewed and distributed to all staff in IT identified as possible Recovery Team members – 
the document is to be kept offsite at the employee’s home and returned at each review cycle for 
updates 

6) Time windows for full recovery and phase 2 recoveries (return to production) are established and 
agreed to with management and the business. 

DR Preparation Checklist 2 – DR Readiness Level 

The following checklist should be reviewed monthly for the highest readiness level.  Less frequency is probably 
OK, but may result in out-of-date recoveries of certain things.  At a bare minimum, when you patch your 
systems in any way (OS, new Apps, Website changes, etc…) you should review the checklist and ensure that it 
is up-to-date. 

1) Critical DR systems have been imaged and converted to VMWare systems where applicable?  

a. DR systems that are imaged have good flat-file backups? 

b. DR systems that cannot be imaged are current on their backups and patch levels and DR 
documentation changes are made as needed? 

2) CommServe DR Backups are rotating offsite daily and are successful? 

3) ER Backup Media is identified on a report that includes the media label for quick identification and this 
report is stored offsite with the DR media? 

4) VMWare based flat-file systems are at the most current revisions? 

5) DR Documentation reflects all changes in architecture? 

6) DR Kit is updated with new CD’s as needed to ensure that all patches, applications, OS’s and other 
tools are available in the KIT? 

7) Serial numbers and passwords are current in the offsite DR Kit? 

8) DR Kit is offsite and stored? 

Anything not right should be remedied immediately and the appropriate changes made to all documentation.  
This step is most often overlooked and even the most detailed DR plan will be badly outdated in no time if 
many changes occur to the environment and the doc is not updated as well. 

 

Recommended tools and information to put on your DR Tools CD and to have as part of your 
prep: 

o If you are using Windows and Exchange:  MBConn Tool from Microsoft – used to reconnect mailboxes 
in bulk that are moved to a new server 

o For Windows:  DriveSnapshot - http://www.drivesnapshot.de/en/ - allows you to image any running 
windows server and P:2:V the image (great for generally converting to VMWare, too)  NOTE – it is 
lousy for imaging transactional systems unless they are stopped first (SQL and Exchange) so it is 
much better for those application servers that you need to bring online (Peoplesoft Domain and 
Process Scheduler servers are great candidates for this treatment!) 

o For SQL Server (and really for any databases you might use):  SQL scripts for your databases – you will 
have to figure them out, but running a canned script beats the heck out of changing options hunt-and-
peck style one at a time! 

o Winzip – often overlooked and very useful 

Anything else you can think of – remember the building is a smoking hole and you can not access anything in it.  The 
more you get offsite now, the better off you will be in the event of a DR situation! 
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The Plan - defined and scoped 
 

Scope 

This document details in depth the steps, tools, and resources required to recover a CommVault based data 
center during the critical first hours after a major disaster.  The plan is based on a combination of CommVault’s 
unique Disaster Recovery capabilities and speed and VMWare’s unique ability to virtualize a library of critical 
systems and use that library in the DR scenario. It will guide you literally click-for-click through the setup of the 
core DR systems such as the CommCell and the ESX recovery server(s), and the restoration of updated data to 
client systems. 

This document DOES NOT deal with restoring the production data center or migrating recovered data to the 
production data center.  Those are other guides that need to be researched and written by you for your specific 
environment.  This guide focused on what, how, and where for DR so that you can get the core systems up and 
running in as short a time as possible. 

 

Glossary 

Please read this section.  There are terms and phrases used in this guide that have great, but may mean 
nothing to you if you have no familiarity with either CommVault or VMware. 

CommVault – Enterprise backup software solution 

CommCell – The Master backup server 

Client – a system running CommVault software that is not directly attached to storage devices 

Media Agent – a component of the CommVault system that is connected to storage devices and acts as an 
intermediary between clients and backup media – in the DR scenario this is the go between server to recover 
data from tape 

Tape Library – a robotic tape library 

Stand Alone Drive – a tape drive directly attached to a server 

Backup Media – any storage media that can be used for holding data (both Disk and Tape) 

ESX Server – This is a server that runs a proprietary version of Linux that houses the VMWare virtual servers 

Virtual server – a server that does not physically exist, i.e. it exists on the network, but there is no associated 
physical hardware 

Flat File Server – used interchangeably with Virtual Server 

DR – Disaster Recovery 

Console – used interchangeably to mean either the console of a software application (such as the CommCell 
Console) or the actual physical screen of the computer you are working on. 

 

Assumptions 

This document assumes that everyone who knows anything about your environment just  returned home to the 
Aurellian Mother Shipand because of their high-treason your building is a cinder cone.  It is written so that 
ANYONE can use it to recover the core systems.  The only assumptions made are:  

• The reader of this document has access to your Disaster recovery kit 

• The reader has recalled 10-30 days worth of your offsite tape media (depending on your rotation model) 

• Wherever you are performing your recovery you have some sort of hardware – some basic specs are listed 
in a later section. 

• Te reader has seen a computer before and is able to at least follow basic command instructions such as 
“Browse to the C Drive” 
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Text and Formatting Conventions Used in this Document 

NOTE <- Denotes a place where we have seen anomalous behavior in testing.  You may or may not need the 
information the note contains. 

Servername  - or -  filename  <- anything written in italics should be interpreted as “insert your information 
here” 

Wherever possible, steps that have to be repeated have been grouped together to shorten the document.  They 
will follow this format: 

22. This is a set of steps that you must repeat for several objects – repeat them in the order you see here: 

a. Do this 

b. Then this 

c. Then this 

d. Then repeat 

23. then move on 

A not e about “Browse to” or “open” or “explore” – it is assumed that you know enough to browse to the C 
drive or open the CD Rom drive or explore the folder.  Wherever possible the document standard has been set 
to “Browse to ….”.  It is assumed that once you are done with a browse window you can close it.  Further note 
that there are two types of browse referenced in this guide – a browse as discussed here and a browse in the 
CommCell during a restore.  The CommCell browse steps are fully detailed in the step itself. 
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DR Checklists 
 

The most important part of any DR plan is this one.  Your DR checklists serve not only to provide whoever is 
performing the DR itself, but also for you to identify those items that you need to plan for, provide in your DR 
Kit, and otherwise may not have thought of. 

 

Checklist 1 - DR Kit Checklist 

Your DR Kit will undoubtedly vary from the concept kit presented here based on your environment and 
application needs.  The kit here is the bare minimum required to rebuild the CommVault environment and the 
ESX server(s) in order to perform the DR itself: 

1. CD Set 1: 

a. QiNetix Disks (CommVault Install Media – 2 copies) 

b. CommVault Resource Kit (2 copies) 

c. Windows Server 2003 CD(2 copies) 

d. VMWare ESX Server CD (1-4 copies or more) 

2. CD Set 2: 

a. SQL2000 and SP4 CD (2 copies)  

b. Exchange 2000/2003 CD 

c. APPLICATIONS/SCRIPTS/ETC – you need to define these for your environment 

d. Tools CD – this should contain any utilities and resources needed to recover the environment 
(a bare minimum list is included in the overview document that precedes this guide) 

3. Copies of this document 

4. Documentation of the computer name and IP address of your CommVault CommServe system – 
recovery through this guide is dependant on using the exact name and IP of your production 
CommServe 

5. Serial numbers for MS applications, VMware, and any other serial numbers or codes/keys/etc… 
needed to install the DR software.  These can be printed or on a CD – whatever is easier. 

6. Any required usernames and passwords sealed in an envelope in the kit 

7. Ten (10) 3Com 3C90x Network Cards (required in case the DR hardware supplied is incompatible with 
VMware) <- This is recommended due to the limitations of the ESX hardware support, but is not 
required 

 

Checklist 2 – Recalled Containers 

One thing that you may not being doing and 100% need to be is sending your ER Backup tape offsite daily 
(even if it is just in your backpack or briefcase) – this tape is the cornerstone of recovery.  No ER backup – no 
recovery.  Period. 

If you are not doing so already, it is highly recommended that you generate a scheduled report daily that has 
the tape ID of the CommVault ER Backup tape on it, and keep it in your tape case.  This will speed recovery of 
the CommServe during the first phase of the DR and saves a ton of time up front. 

Failure to generate this report does not cause failure of the DR plan – it just makes it take longer – and in some 
cases this could be significant if you have many tapes! 
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Checklist 3 – Recovery Progress Checklist 

This checklist is something that needs to be defined for your environment.  It is the “how far are we?” guide for 
management and for your own team to quickly ID where you are and how much you have left to do.  A simple 
example would be: 

CommServe Rebuilt:  _______________  25% 

ESX Host(s) Built:  _______________  50% 

Flat Files Restored:  _______________  75% 

Servers running:   _______________  100% 

This is obviously an incredibly simplistic checklist of status, but it gives the concept for what you need to checkpoint.  
Major milestones should be easily identifiable and measurable.  Do not forget to add testing in prior to saying that the 
systems are 100%! 
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DR Plan Execution Guide 
This section defines not the “what” you are going to do, but more of the “how” to do it.  It includes information 
to identify DR hardware and the systems that are required.  This is useful not only in a 3rd part scenario such as 
a SunGuard site, but in the event that you also have your own site for recovery since it could be a site that is 
not frequently used. 

 

Site Arrival “To Do” List 

Identify Roles and Role Holders 

There are 3 key roles in the DR process: 

1) Incident Commander – manages the DR process and the actual steps to get the DR done – this role 
should be held by the most senior person available as they are responsible for communicating up to 
corporate management and working with any vendors that are required to perform the recovery.  

2) Recovery Lead – This is the person who will be designated as being in charge of ensuring that the 
steps are followed and that all tasks are checked off when completed.  Someone who will be actually 
performing the recovery and working the server side should hold this role. 

3) Recovery Team – these individuals are the ones doing the actual builds, restoring data, and ensuring 
that the systems are back up and working. 

You may have other members of your team but the ones here are the most simple to ID and consistent across 
most environments and needs. 

Identify Hardware 

Your first job upon arrival is to verify you have the correct systems and that they are all preconfigured and 
ready to have the OS loaded. (This is contractual on the part of many 3rd party DR site providers, but would 
need to be done by the team at a site that you may own) 

Hardware Identification Guide 

The servers are identifiable as follows: 

Server Hardware Count Will Become 

Attached Tape Drive AND 
Library (remove a stand-
alone drive from another 
server if needed) 

1 CommVault COMMSERVE 

Server with Attached Tape 
Drive and maximum available 
disk space 

TBD By You! Major SQL /Oracle type DB 
Servers or Servers requiring 
large restores to recover data 
changes 

Servers with no attached 
tape drive, maximum RAM, 
and decent disk space 

TBD By You! ESX Servers 

Servers with no tape drives 
that are leftover 

TBD By You! Configure as console machines 
for multiple system access (See 
Section 10) 
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Server Hardware Priority Matrix 

Upon arrival consult with the Sun Guard representatives and determine which boxes have the best 
configurations.  It is recommended that you use them in descending order as seen here: 

Highest:  ESX Server(s) - Needs RAM more than disk – use RAM heavy servers for ESX   
  hosts first then follow up with lighter RAM servers in order. 

Large Database Servers - Needs a minimum of twice the disk space of the database you are 
restoring and RAM enough to run the DB system 

  CommServe - Needs disk and at least 1 gig of RAM (2 preferred) 

Lowest:  Console systems - Needs minimal disk and RAM 

Absolutely you should reorganize the hardware to fit the needs of the systems and the needs of your own DR 
environment.  The guide is merely for reference and should be used as a “best practice” type of guide and you 
should expand the list above to meet the needs of your particular environment. 

 

Instructions for the DR Incident Manager 

Order of operations and dependencies 

Once you have identified the servers it is time for the DR Incident Commander to  break out the DR plan using 
the information that follows to maximize the amount that can be done in parallel.   It is recommended that the 
guide be divided up into no less than 3 parts so that the maximum work in parallel can be done.  In general you 
should recover the CommCell in parallel with building and configuration steps of the ESX and other servers 
such that the baseline is reached at roughly the same time so restoration of data can begin. 

In general you should establish a clear plan of attack and fill in this section in a way that makes it clear to the 
Incident Commander how to assign resources so that the critical steps get done first.  The DR Incident 
Commander needs to be aware of these priority goals and decide, based on the immediate business need, how 
to assign the resources required to meet that objective before moving on to the next task. 

There are three major steps in recovery using CommVault and VMware systems: 

1) Install the CommVault backup software environment – a process made faster and easier by the built-in 
DR backup and Media Explorer tools provided by CommVault to facilitate the process 

2) Deploy a VMware ESX Server 

3) Deploy a CommVault Linux agent onto the VMware ESX Server physical system 

4) Restore the VMware system virtual disk files using CommVault, to rebuild the guest-hosted virtual 
machine environment onto the ESX Server – a rapid and easy process 

5) “Create” the restored virtual machines using the ESX Server Web Management Console, and 
reestablish Active Directory, IP, name and applications services 

6) Recover applications, database and file system data into the virtual machines using CommVault – the 
exact steps for each will vary according to what is necessary for the application 
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Summary of the steps required: 

Step Substeps Description Notes 

Process for recovering the CommVault backup software environment on a Windows Server 2003 system 

Install Windows Server 
2003 – for the CommCell 

 

Install CommVault 
CommCell 

Install the 
CommVault 
CommCell 
Software 

Install CommVault 
SPS/Patches 

Quickly rebuilds the 
CommVault backup and 
recovery environment 

Does not require duplicate server 
systems nor network equipment 
to your production environment 

Install the 
CommVault 
Media 
Explorer 

Install CommVault 
Resource Kit – Media 
Explorer Tool 

Enables you to recover the 
CommVault DR backup 

Media Explorer is a tool provided 
by CommVault to facilitate DR 
recovery 

Restore the CommVault 
DR backup meta data from 
the DR tape  

Enables you to quickly and 
easily recover the CommVault 
CommCell meta data 

Recover from the restored 
DR backup copy, using DR 
Restore command 

Enables you to quickly and 
easily rebuild the CommVault 
CommCell environment 

Recover the 
CommVault 
CommCell  

 

Clean up the recovered 
CommCell environment 

Resets defaults to facilitate 
DR recovery process 

Avoids the need to rebuild the 
CommVault CommCell software 
environment, by rebuilding the 
meta-data database complete 
with client and sub-client 
definitions 

Load the CommVault 
MediaAgent software 

Required for library 
management 

Can manage libraries or stand-
alone drives equally effectively 
and is required to actually execute 
a restore 

Prep the 
system to 
restore files 

Migrate tapes and 
configure shared index 
cache 

Enables the CommVault 
CommCell to “see” the tapes 
in the library and begin 
restores 

Avoids and eliminates the need 
for tape scanning, which is the 
time-consuming step typically 
required by other backup software 

Install 
Client 
Agents 

Load CommVault agent 
software on the ESX 
server 

Enables the CommVault 
system to restore the Linux 
flat files 

Avoids rebuilding systems from 
scratch and having to perform 
tedious restores and 
configurations to achieve system 
recovery 

 

DR Plan Flowchart 

A simple chart of your DR flow should go here – this provides a VERY powerful representation of what is 
expected and in what order it needs to happen. 
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CommCell Recovery Steps 
 

This section details the steps needed to recover the CommVault ComCell.  The ComCell is the core of the 
CommVault system, and no data can be restored without it.  These steps should be performed on the physical 
system identified as the CommCell in step 4. 

 
Install the CommCell Software 

Install Windows Server 2003 

Follow these steps to install Windows 2003 server on the CommCell machine: 

1. Verify that there is tape drive and a tape library hooked up to the CommCell server identified from step 
3 

2. Insert the Windows Server 2003 CD into the server, and power on the machine 

3. The server will boot from the CD and begin Windows 2003 setup 

4. Eventually you will see a welcome to windows setup text screen with 3 options – Hit ENTER to continue 
with setup 

5. Windows Licensing Agreement screen – hit F8 to continue 

6. Partition selection screen – you should see something similar to this: 

40000 MB Disk 0 at Id0 on bus 0 on… 

Partition1 (EISA Utilities)… 

  Unpartitioned Space 

7. Highlight the Unpartitioned Space and hit ENTER 

8. Format Partition Option – select Format the partition using the NTFS file system (Quick) and hit enter 

9. Formatting progress bar will appear – it should go pretty quickly 

10. A file copy progress bar will appear and copy the Windows Server files 

11. The system will confirm all files copied and reboot automatically – when it comes back up it will 
perform some further file copies and go into a more GUI based setup. 

12. The first GUI setup prompt is for the language and region options – Click Next 

13. Name and organization – type the correct values into both fields and click Next 

14. Volume License Key – Enter the  serial number  and click Next 

15. Licensing Mode – Click Per Device or Per user Radio Button and then click Next 

16. Computer Name – Enter the name of the computer exactly as it was in your production 
environment!  -  Administrator Password – enter the admin password on the DR password list from the 
DR kit and then click Next 

17. Insecure password prompt – Click Yes 

18. Date and Time Settings – set the correct date, time and Time Zone and click Next 

19. Installing Network will appear on the left side of the screen with a progress bar.  When the progress 
bar is gone you will see the Network Settings Window – Click Next to continue (you will change these 
settings later after setup completes) 

20. Workgroup or Computer Domain screen – leave defaults and click Next 

21. Now pretty much you get to sit and watch for about 20-30 minutes while setup completes.  This is a 
good time to update your checklists and to verify that everything is proceeding correctly. 
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22. The server will reboot once all of the setup tasks are completed.  When it returns to the login prompt, 
log in to the server using the admin password you entered above from the DR password list 

23. Once the login is completed you will see the “Manage your Server” screen – you can close this and go 
to Start -> Control Panel -> Network Connections Right click on the network connections and choose 
Open from the menu 

24. Right click on the connection named Local Area Connection and click properties 

25. Click the Configure button 

26. Click the Advanced tab 

27. In the Property list you should see something equivalent to Link Speed/Duplex Mode or Media Type – 
click on it to highlight it 

28. In the drop down to the right choose the option that is closest to:  100 Full 

29. Click OK 

30. This will close the properties window - Right click on the connection named Local Area Connection and 
click properties again 

31. Highlight the Internet Protocol (TCP/IP) in the configuration menu, and then click the Properties button 

32. The Properties window will open.  Click the radio button next to “Use the Following IP address” in the 
fields enter the following information: 

o IP Address:  The same as your production CommServe 

o Subnet Mask: The same as your production CommServe 

o Default Gateway:  The same as your production CommServe 

o Preferred DNS Server: This should be the IP of your DNS server in the DR environment 

o Secondary DNS Server:  Any accessible and active DNS server 

33. Click the Advanced button at the bottom right 

34. Click the WINS tab 

35. Click the Add button, and in the Add Wins Server IP field, type in the Ip of any WINS servers in your DR 
environment and click the Add Button 

36. Click OK to close the advanced settings 

37. Click OK to close the TCP/IP properties window 

38. Click the Checkbox next to “Show Icon in taskbar when connected” and then Click OK 

39. Close the Network Connections window by clicking the “X” in the upper right corner 

40. Browse to C:\Windows\system32\drivers\etc and find the file called hosts – right click on it and 
choose Open from the menu 

41. You will be asked what to open it with, select Notepad from the list and click OK 

In the file, scroll to the bottom and add in an entry for all of the client systems you intend to build in 
your DR environment. 

42. Save the file and close notepad 

Windows server is now set up enough to begin recovering the CommCell . 
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Install CommVault 

Once the system is running Windows Server 2003, log in to it (if you have not already) and insert the 
CommVault Install Disk 1 from your CD kit.  This should auto-start the installation process.  

1. At the initial setup screen, leave the language selection as English click Next 

2. Click on the selection for Install QiNetix Software on this Computer 

3. Eventually the setup will start and you will see the Welcome Screen.  Click Next 

4. Anti-Virus Pop Up warning, click OK 

5. License agreement – click the “I accept the terms in the license agreement” radio button then click 
Next 

6. It will take some time for the next screen to appear 

7. Eventually, the Select Platforms screen will appear.  Expand the CommServe Modules by clicking the 
plus sign, and click the box next to CommServe – This will automatically select some other options, 
this is by design.  Click Next 

8. CommVault privileges prompt – click Yes 

9. CommVault Installer Window appears saying that it will now install the Database Engine.  Click Yes 

10. Choose Install path window – leave options to default and click Next 

11. Second Choose install path window – leave all options default and click Next 

12. SQL Install will begin.  This process can take up to 15 minutes.  It will complete and present the next 
screen. 

13. You will be prompted to enter the SQL SA account password – leave the password blank and click Next 

14. Installing Database Engine.  This may take some time.  When this is on the screen, go get a soda and 
take a deep breath.  It really will take another 20 minutes or so to complete the SQL installation. 

15. When the Database Install is completed you will be prompted to install the Java Runtime Environment.  
Click Yes 

16. A Screen will popup telling you that it is installing the JavaRuntime, Please wait 

17. Destination Folder prompt – leave all defaults and click Next 

18. CommServe Database Path – leave defaults and click Next 

19. CommServe Name – leave the entries default and click Next 

20. CommServe DR path – click the radio button for “Use Local Path” in the path field type in:  c:\cvdr  
Click Next 

21. Galaxy Firewall Services screen.  Leave default (No do not configure) and click Next 

22. Apply a License screen.  Click Evaluation radio button and click Next 

23. Prompt to confirm evaluation license Click Yes to agree and continue 

24. Summary screen displays all settings selected.  Click Next to install the CommCell Software 

25. CommVault Installer prompt to log off – Click Log off – the computer will log off log back in and setup 
will resume automatically and copies files 

26.  Administrator Account configuration screen – the name is prepopulated with cvadmin.  For the 
password use password for simplicity - it will be erased when the DR database restore completes. 

27. Media Password screen – leave both fields blank and click Next 

28. CommVault Installer prompt – user rights – Click No 

29. Setup complete – Confirms version and software installed.  Click Finish to complete. 
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Install CommVault SPS/Patches 

1. Once you have completed the installation of the CommServe software you should now log into the 
console to download the patches to the system. 

2. Click on Start -> Programs -> CommVault -> QiNetix -> CommCell Console for Java 

3. You will be prompted to log into the CommCell – use the username and password you entered during 
setup 

4. Once the CommCell opens, you will see 3 panes in the window.  In the one labeled CommCell browser 
right click on the root level of the tree visible in the window - Form the Menu select All Tasks -> 
Download Updates 

5. In the resulting dialog box – click the Run Immediately radio button and click OK 

6. You will see an entry in the event viewer window that says the download has started – once an event 
appears saying the download is complete you can install the patches 

7. Right click again on the root of the CommCell Browser tree and choose All Tasks -> Install Updates 

8. You will see a dialog box asking what systems to install the patches on – ensure the “All” checkbox is 
selected and click OK 

9. You will see an event in the event viewer that says update installations have started – at this time the 
CommCell Console will most likely close while it is updating – this is normal.  Updates can take up to 
30 minutes – in order to see the status of the update process you can look for the cvupdates.exe 
process in task manager 

10. Once the updates are completed you are now ready to restore the CommServe DR backup data! 

 

Recover CommVault from Backup 

Install CommVault Resource Kit – Media Explorer Tool 

1. Put in CommVault Resource Kit CD from Media Kit 1 

2. When the browse window opens, find the file called:  QiNetix_590_RP.exe – double click the file 

3. Welcome pop up screen.  Click OK 

4. Location confirmation Screen – in the path window, type in C:\CVRP and click Unzip button 

5. A progress bar appears and the files are unzipped to the destination specified. 

6. Confirmation popup files unzipped successfully.  Click OK 

7. Click Close on the Winzip Window 

8. Browse to the C:\CVRP folder and drill down through the directories as follows Windows -> 
MediaExplorer 

9. In the MediaExplorer folder, double click the Media Explorer.exe file to launch the Media Explorer 
setup 

10. Welcome splash screen – Click Next 

11. Destination Folder screen – leave default and click Next 

12. Ready to install screen – Click Next 

13. Files will copy 

14. Confirmation screen – Click Finish 
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Restore the DR backup from the DR tape 

1. Find the Daily offsite Report from the tape case with the latest possible tapes in it. 

2. Identify on the report the media ID which contains the DR backup for the CommCell 

3. Insert the DR backup tape into the stand-alone drive on the server 

4. Browse to c:\program files\CommVault Systems\Media Explorer and find the file called 
MediaExplorer.exe – Double click the file to launch the program 

5. In the Media Explorer screen.  First click the radio button next to Tape then click the Drive Detect 
button 

• NOTE – if no tape drive appears in the field, you may need to load tape drivers.  Refer to the 
troubleshooting appendix section on tape drive and library issues for help. 

6. From the Media Type drop down list choose ULTRIUM (NOT ULTRIUM V2) 

7. In the drop down for “Display data correspondent to:” list select Express Recovery 

8. Click the Catalog Files Button – this process will take about 5-10 minutes 

9. A window will popup saying catalog completed – Click OK 

10. You should see a single line in the grid at the bottom of the window.  It should have the following 
entries: 

Client name: ENGCVM01  

AppType:  Galaxy ER 

(If you see more than one, look at the Job ID field.  You want the one that is the highest number) 

11. Click on the line and then click the Restore Files Button 

12. In the destination window pop up type the following into the path field:  C:\CVDR 

13. Click the OK button to restore the files 

14. A prompt will appear reminding you to insert the right media (this happens regardless of what tape is 
in the drive).  Ensure you have not removed the tape from the previous step, and click OK 

• NOTE:  There is no real progress bar or anything during this step.  The status at the bottom of the 
Media explorer window will change as it restores the files, but there is not meter of how long it 
takes.  In testing it seems to be right around 15-20 minutes 

15. A prompt will appear when the restore is completed.  Click OK 

16. Close the Media Explorer window by clicking the Exit button 

 

Recover the CommCell using the DR Restore 

1. Browse to:  to c:\program files\CommVault Systems\Galaxy\Base 

2. Find the file called:  CommServeDisasterRecoveryGUI.exe – double click the file to execute the 
program 

3. The CommServe Recovery screen appears 

4. Click the SQL Restore Tab 

5. Click the button next to the Restore File field (the … button) 

6. Browse to c::\cvdr\Program Files\CommVault Systems\Galaxy\CommServe ER\ and locate the file 
called commserv_FULL.dmp – highlight the file and click Open 

7. Click the Submit Button 

8. The Restore DB files as: dialog window appears.  Click the Restore ER DB button 
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9. Confirmation prompt – click Yes 

10. The restore process will begin – you will see a timer in the lower right of the window that counts up the 
time it has taken – This process will take about 15 minutes or slightly longer depending on the size of 
the ER DB 

11. When the restore completes, you will be prompted with a DR Restore completed successfully window.  
Click OK 

12. Click the Post Recovery Tab 

13. Click the checkboxes next to:  “Mark all Tapes Exported”, “Delete all Active jobs” , and “Disable all 
Media Agents” 

14. Click Submit 

15. Media Export Prompt – Click Yes 

16. Delete all active jobs prompt – click Yes (This make take some time – do NOT close until you get the 
third prompt) 

17. Disable Media Agents prompt – click Yes 

18. Operations completed – Click OK 

19. In the CommServe Recovery window click Close 

20. Reboot the Server 

21. While the server reboots, remove the DR tape from the stand alone drive 

 

CommCell Cleanup and Pre-Restore Steps 

Cleanup Steps on the recovered CommCell 

1. Once the server has rebooted, log in as administrator 

2. On the start menu, navigate to Start -> All Programs -> CommVault QiNetix -> Galaxy -> CommCell 
Console for Java GUI 

3. When the login prompt window appears, type in the username and password from the password list in 
the DR kit 

4. The CommCell Will open with 3 screens (for full details on the CommCell and its use, see the Backup 
Operations Guide included in the DR Kit) 

5. In the CommCell Browser window of the console, right click on ENGCVM01 at the root of the console 
and select Properties from the menu 

6. In the properties Menu, click the Activity Control tab 

7. Uncheck the boxes next to everything EXCEPT “Enable All Job Activity” and “Enable Data Recovery” 
and click OK  (This step ensures that no backup jobs try to run while you are restoring creating errors 
on the system, but that you can still perform a restore) 

8. You are now ready to configure the DR Media Agent to begin restoring files to individual DR servers – 
close the CommCell Console (click yes at the confirmation prompt) 
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Prepare System for Restoring Files 

Load the CommVault Media Agent software 
In order to restore files to the systems, CommVault requires a Media Agent configured to talk to the library. 
This documentation will address this configuration as completely as possible since the facilities at Sun Guard are not 
100% guaranteed to match this and could involve a library we have never seen.  Follow these steps to configure the 
Media Agent:  (Refer to the troubleshooting Appendix for some ideas on fixing library errors) 

1. Insert the CommVault Install Disk 1 from the DR Media 2 CD case and setup will launch 

2. Leave the language selection to English and click Next 

3. Click the “Install QiNetix Software on this computer” link to start the setup program 

4. Welcome splash screen – Click Next 

5. Pop-Up confirmation prompt – click OK 

6. License Agreement screen – Click the “I accept the terms of the license agreement” radio button and then click 
Next 

7. After a short time you will see the Select Platforms Screen 

8. Click the plus sign next to Media Agent Modules and then click the box next to MediaAgent 

9. Click the plus sign next to iData Agents and click the box next to “iDA for Windows Server 2003” 

10. Click Next to continue 

11. Removable Storage Service screen – Leave the default Radio Button (Yes, stop and remove the service) 
checked and click Next 

12. Job Results Path – Click Next 

13. Summary – Click Next to begin installation 

14. Installation will process through and you will see the Configure drives and devices wizard prompt  Window 
title is cvmminst)– Click Yes 

15. Select Media Agents Screen – leave defaults and click OK 

16. SCSI device detection screen prompt (cvmminst is the window title) – Click OK 

17. SCSI Detection Screen confirmation again – click Yes 

18. Detect/Configure Devices – click OK 

19. Detection window will pass by rapidly 

20. Confirmation window for discovered device – Click OK 

21. Click Close on the Log window 

22. Library configuration manager screen may be minimized in the toolbar click on it to bring it to the front it will 
list the Attached libraries and drives.  For each library, right click and select “Configure” from the menu 

23. Confirmation prompt.  Click Yes 

24. The status bar at the bottom will say that the library configuration was completed - Click Start on the window 
and then click Exit 

25. Storage Policy selection screen – Leave default selection and click Next 

26. Schedule Reminder – Click Next 

27. Completion Report screen – Click Finish to complete the installation 

28. When Set up exits, log back into the CommCell with the DR user 

29. Right click on the root of the CommCell Browser tree and choose All Tasks -> Install Updates 
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30. You will see a dialog box asking what systems to install the patches on – ensure the “All” checkbox is 
not selected – highlight the name of the CommServe in the list of clients and click the arrow to move 
the client to the right-hand list 

31. Click OK to start the updates  

32. You will see an event in the event viewer that says update installations have started – at this time the 
CommCell Console will most likely close while it is updating – this is normal – in order to see the status 
of the update process you can look for the cvupdates.exe process in task manager 

33. Once the updates are completed you  can log back into the console and complete the recovery steps. 

 

Migrate Tapes and Configure Shared Index Cache 
This will allow the CommCell to see the tapes in the library and to commence restores.  Follow these steps to migrate 
the media: 

1. Place all of the most recent recovered tapes into the DR library 

2. Log into the CommCell console 

3. Open the Policies section in the CommCell Browser by clicking the + sign and then expand the Storage Policies 
area by clicking the + sign next to it 

4. Perform the listed steps for all storage policy copies that use tape copies AND are not associated with a media 
agent system that you will restore data to from a directly attached tape drive! You will move media from other 
storage policies later, but they will go to stand-alone drives attached to servers. 

a. When you click on the Storage Policy name (such as CommServeDR) the copies associated with that 
storage policy show up in the right hand pane of the window 

b. Find any copies where the Copy used tape as the media target and right click on ONLY those copies – 
choose All Tasks -> Migrate Media from the menu 

c. The Migrate Media selection window appears – highlight all tapes (They will have a little VHS tape 
icon next to them in various colors and markings and will also have the ######## formatted 
Barcode) and click OK 

d. The Library Selection Window will appear – Fill in the choices as here: 

i. Select the NEW library configured during the Media agent installation above from the drop 
down list for the first field 

ii. Select the Master Drive Pool Associated with that library (there will only be one) in the next 
drop down 

iii. Select the Drive Pool in the next drop down (again, there will only be one) 

iv. The last field is filled in automatically – leave it to the default 

v. Click OK 

e. You will see a prompt concerning Bar Codes – Click OK 

f. Confirmation Window will Appear (depending on the number of media you moved this may take a 
few seconds or longer to finish) – click Close 

NOTE:  You can confirm that the media have moved by expanding the Storage Resources -> 
Libraries -> (new library name) -> Media by Location -> Exported Media  When you click on the 
last group, you should see the tapes you moved in the right hand pane 

g. Go back and repeat these steps for all of the listed storage policies 

5. Once all the Storage Policies have had the media moves completed find the new library in Storage Resources -
-> libraries in the CommCell Browser window and right click on the library – choose Discover Media from the 
menu (You may get a prompt here, just click OK/Yes to confirm you want to perform this step) this will 
discover that the tapes you loaded earlier are in the library  
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6. When the media moves are complete, expand the Storage Resources -> Media Agents section of the 
CommCell Browser window, and right click on the CommServe name in the list– choose Properties from the 
menu 

7. In the properties window, click the Index Cache tab 

8. Click the Radio Button for “Used Shared Index Cache” – the value should be “INDEXCACHE_4” 

9. Click OK to close the properties window 

You can leave the CommCell console open at this time, as you will be using it extensively from here on out.  You 
are now ready to begin restoring files to the various systems which is detailed at the end of the build guides for 
each DR server 



Best Practices for Disaster Recovery (DR): Using CommVault QiNetix Software and VMware ESX Server Systems to Rebuild Following a Site-Level Disaster 

 
 

 

 
   

22

ESX Server Recovery Steps  
 

Configuring the DR ESX systems is the same for each physical server.  Later, when you restore the guest OS 
servers to the hosts, there will be minor differences.  For this portion, repeat these steps on all ESX servers (the 
physical Servers identified in Section 3 as ESX servers) 

 

Loading VMware ESX Server 

1. Insert the VMware ESX Server CD From the DR kit into the first system identified as an ESX host 

2. Power on the system and it will boot up to the CD 

3. A Text based menu will appear with a  boot:  prompt at the bottom of the screen 

4. Hit Enter and the system will go into the default setup mode 

5. The setup program will begin (it scrolls a lot of information on the screen with the Linux Penguin in the 
upper left corner) 

NOTE:  The setup program looks like an old MS DOS application screen with grey “windows and a 
blue background initially.  If you receive a prompt that says “Unknown PCI Devices” and lists a 
Class of “EthernetController” in this format, then you must power down the system, remove the 
existing network cards and replace them with the ones from the DR kit.  Refer to the 
troubleshooting appendix section on Installing 3Com Ethernet Cards. 

6. Setup will greet you with a windows-like splash screen.  Begin by clicking Next in the lower right 
corner 

7. At the Install Options screen – click Next 

8. At the Licensing screen, click the checkbox next to “I accept the terms of the license agreement” and 
then click next 

9. Serial number entry screen : 

1. You will be presented with a screen to enter the ESX serial numbers with 2 rows, each with 4 
blocks of text field to type into.  The first row is where the ESX serial number is entered – the 
second row contains the SMP serial number.  They are listed here: 

ESX Server Serial Number YOUR SERIAL NUMBER HERE 

ESX SMP Serial Number YOUR SERIAL NUMBER HERE 

2. When typing the serial numbers in, they are CASE SENSITIVE 

10. After entering in the Serial Numbers, click next 

11. At the device allocation screen, you only need to change the setting at the very top right for “Reserved 
Memory” – Click the drop down and select 272M (up to 16 virtual machines) – Click Next 

12. Partition Table Popup message – click Yes 

13. Disk Partitioning Screen – This is somewhat complex, so follow the detailed steps below to ensure the 
disk is set up correctly (ALL MOUNT POINT NAMES ARE CASE SENSITIVE!): 

1. First, Click the Manual Partitioning radio button, and then click Next 

2. The Defining Disk Partitions screen will open.  There are 4 buttons on the screen, to begin, 
click New 

3. The New Partition screen will pop up Enter the following values into the corresponding fields: 

 Mount Point: - Select from Pulldown menu - /boot 

 File System Type – Select from Pulldown – EXT3 
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 Allowable drives – leave default 

 Size – type in 50 

 Additional Size options – leave default 

 Click the box next to “Force to be a primary partition” 

 Click OK to create the partition 

4. You will be returned to the partition screen every time you click OK.  Click New to open a new 
partition menu again, and enter the values below 

 Mount Point: - Leave blank 

 File System Type – Select from Pulldown – swap 

 Allowable drives – leave default 

 Size – type in 2048 

 Additional Size options – leave default 

 Click the box next to “Force to be a primary partition” 

 Click OK to create the partition 

5. You will be returned to the partition screen every time you click OK.  Click New to open a new 
partition menu again, and enter the values below 

 Mount Point: - Select from pulldown - / 

 File System Type – Select from Pulldown – ext3 

 Allowable drives – leave default 

 Size – type in 2048 

 Additional Size options – leave default  

 Click the box next to “Force to be a primary partition” 

 Click OK to create the partition 

6. You will be returned to the partition screen every time you click OK.  Click New to open a new 
partition menu again, and enter the values below 

 Mount Point: - Select from pulldown - /home 

 File System Type – Select from Pulldown – ext3 

 Allowable drives – leave default 

 Size – type in 2048 

 Additional Size options – leave default 

 Leave all other options unchecked 

 Click OK to create the partition 

7. You will be returned to the partition screen every time you click OK.  Click New to open a new 
partition menu again, and enter the values below 

 Mount Point: - Select from pulldown - /var 

 File System Type – Select from Pulldown – ext3 

 Allowable drives – leave default 

 Size – type in 2048 

 Additional Size options – leave default 

 Leave all other options unchecked 
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 Click OK to create the partition 

8. You will be returned to the partition screen every time you click OK.  Click New to open a new 
partition menu again, and enter the values below 

 Mount Point: - Select from pulldown - /tmp 

 File System Type – Select from Pulldown – ext3 

 Allowable drives – leave default 

 Size – type in 2048 

 Additional Size options – leave default 

 Leave all other options unchecked 

 Click OK to create the partition 

9. You will be returned to the partition screen every time you click OK.  Click New to open a new 
partition menu again, and enter the values below 

 Mount Point: - leave blank 

 File System Type – Select from Pulldown – vmkcore 

 Allowable drives – leave default 

 Size – type in 100 

 Additional Size options – leave default 

 Leave all other options unchecked 

 Click OK to create the partition 

10. You will be returned to the partition screen every time you click OK.  Click New to open a new 
partition menu again, and enter the values below 

 Mount Point: - leave blank 

 File System Type – Select from Pull down – swap 

 Allowable drives – leave default 

 Size – type in 2048 

 Additional Size options – leave default 

 Leave all other options unchecked 

 Click OK to create the partition 

11. You will be returned to the partition screen every time you click OK.  Click New to open a new 
partition menu again, and enter the values below 

 Mount Point: - Manually Enter - /vmimages 

 File System Type – Select from Pull down – ext3 

 Allowable drives – leave default 

 Size – type in 8192 

 Additional Size options – leave default 

 Leave all other options unchecked 

 Click OK to create the partition 

12. You will be returned to the partition screen every time you click OK.  Click New to open a new 
partition menu again, and enter the values below 

 Mount Point: - leave blank 
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 File System Type – Select from Pull down – vmfs2 

 Allowable drives – leave default 

 Size – leave default 

 Additional Size options – click Fill to maximum allowable size 

 Leave all other options unchecked 

 Click OK to create the partition 

14. You will be at the partition screen, and should see all to the partitions you created in the listing.  Verify 
you have followed all the 12 steps to create the drives, and then click Next 

15. The Network configuration screen will come up.  Fill in the information for the ESX system you are 
building: 

1. These values are the same for all ESX systems: 

 Netmask – Your Subnet Mask 

 Gateway – Your Default gateway 

 Primary DNS – Your DNS server in the DR Environment 

 No Secondary DNS 

16. After filling in the appropriate values, click Next 

17. The Time Zone screen will appear – click on your location and click Next 

18. Root password selection – use the password from the DR password sheet – click Next 

19. Final confirmation screen – clicking Next will begin the file copies to set up the ESX server 

NOTE:  If you see a message that setup has failed something like “Unhandled Exception Error”, 
and the system reboots you have messed up the disk partitions and need to restart setup from the 
beginning. 

20. The progress screen will come up and will track the installation progress (this can take up to 30 
minutes on a slower system).  When it is complete you will see the congratulations screen.  Click Next 

21. Setup will terminate, eject the CD and reboot the system.  Once the reboot is complete, you will see a 
screen that includes the text “Hit Alt-F2 to access the console” at this point, the ESX server is ready to 
have its configuration finalized and have the CommVault agent installed on it. 

 

Post ESX Installation Configurations 

After loading the ESX server you access it from another system on the same network.  There should be at least 
one other functional server at this point, so log into it and open a web browser.  Follow these steps to finalize 
the configuration of the ESX server: 

1. Click on Tools -> Internet Options in the menu bar 

2. In the Internet Options pop-up, click the Security tab 

3. There will be a slider (looks like a volume controller) on the left of the window – slide it all the way 
down 

4. You will get a prompt telling you this is bad – click Yes 

5. Click OK to close the Internet Options menu 

6. In the browser’s address bar type in the name of the ESX sever you just finished loading and hit enter 

7. Security Alert Pop up warning – Click the checkbox and then click OK 

8. Second Security Alert – Click Yes 
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9. The ESX login page will appear - The username is root and the password is the same password you 
entered during the setup of the ESX server – type them in and click the Log In button 

10. The ESX management webpage will appear with a list of things that are not configured at the top with 
orange-yellow Triangles next to them 

11. Click on the word “Reconfigure” next to the first one (Should be No Swap Space is configured) and 
follow these steps: 

a. The Swap Configuration Menu Window will open – there should be only one link – Create…  
Click on it 

b. The configuration menu options will appear.  You only need to modify the Size setting to read 
3072 – Click the OK button at the bottom to confirm the change NOTE – it may be off the 
bottom of the screen.  You might have to drag the window way to the top to see it. 

c. You will return to the Swap Configuration Screen – This time you will see the configured file, 
along with a link that says Activate…  - Click the link 

d. You will be returned to the main screen which will refresh and leave only one unconfigured 
option 

12. Click on the word “Reconfigure” next to the remaining missing option (Should be No Virtual Ethernet 
Switches found) and follow these steps: 

a. Near the top of the screen that pops up, embedded in the text, is the word create – click on it 

b. You will be prompted to enter a network label and to bind the network to an adapter.  On the 
Virtual Switches tab, type in the Private network Virtual switch name that you used on your 
production ESX system (CASE SENSITIVE) in the Network Label field do not select any other 
options and then click Create Switch 

c. When you are returned to the Virtual Switch list, you should see your newly created switch.  At 
the top of the screen is the overview header and in that section is another Add.. link – click 
this Add link (Not the one that is in the section for the switch you just created!) 

d. You will again be prompted to enter a network label and to bind the network to an adapter.  
For this switch, type in the public network virtual switch name (CASE SENSITIVE) in the 
Network Label field, and then click the check box to bind to the adapter Outbound Adapter 0 – 
Click the Create Switch button to create the switch 

e. You will be returned to the Virtual Switch Configuration screen and see your two switches.  
Click the Close link near the top right corner of the screen (not the “X” on the window itself) to 
exit 

13. Back at the main configuration screen click the Options tab 

14. Click the link that says Storage Management … 

15. In the list of configured partitions, scroll to the bottom and locate the last listed partition – click the 
Edit link next to it 

16. In the Volume Label field, type in the label of your VMFS-2 volume you used in production 
(Capitalization matters!) and then click the OK button 

17. Back in the Storage management screen, click the Close… link in the upper right corner to exit Storage 
Manager 

18. In the main screen, click the tab labeled Status Monitor 

*** NOTE If the CommCell is not fully recovered, you must pause at this point until it is rebuilt *** 

You are now ready to install the Linux File system agent on the ESX server(s) 
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Loading the CommVault Linux Agent 

For this series of steps you need to be physically on the ESX server console to load the Linux file system agent.  
The console may be a black screen – wiggle the mouse or hit any key to activate the console message, and then 
follow the steps below to get the agent installed: 

1. Insert the CommVault Install Disk 2 (Unix, Linux, Mac) from the CD case labeled DR Media 2 into the 
ESX server 

2. At the ESX console, hit alt-F2 to access the LINUX console 

3. At the login prompt log in as root with the password you assigned during setup 

4. type cd /etc 

5. type:  vi hosts – this will open VI the Linux editing software tool 

6. You will see a screen that has a few lines of text when vi opens the file.  The last line should be the IP 
address of the server and the server’s name 

7. Press the “I” key on the keyboard to enter insert mode – use the arrows to navigate to the end of the 
line that has the  IP address of the server on it 

8. Hit Enter and then type the following on the next line:  10.54.42.10 (Tab Key 2 times) engcvm01 

9. Once you have entered the line, hit the ESC key and type:   :wq  (include the : ) and then hit Enter 

10. You will see a message that the file was written 

11. Now type: cd /root 

12. Type in this command:  mount -t auto /dev/cdrom /mnt/cdrom - and hit Enter - You should see a 
message saying that the device was mounted as read only (there is no unmount command in ESX, so if 
you put in the wrong CD, you will have to reboot and rerun the command with the right CD) 

13. Type:  /mnt/cdrom/galaxy/cvunixpkgadd – Hit Enter to launch the CommVault setup program 

14. Welcome screen – hit enter 

15. License Agreement – press Enter to start the license scrolling and then hit space bar about 12-15 times 
to scroll to the end – type a “y” at the prompt and hit Enter 

16. Cluster support option screen – type a “1” (number one) and hit enter 

17. Client Hostname prompt – hit Enter 

18. Select the Galaxy Module to install – type a “3” (Number 3) and hit Enter 

19. Galaxy Base package installation prompt – hit Enter 

20. CommServe Name prompt – Type in “engcvm01” and then hit Enter 

21. Installation Directory prompt – just hit Enter 

22. Directory Confirmation – Hit Enter 

23. Galaxy Log Directory – Hit Enter 

24. Directory Confirmation – Hit Enter 

25. Galaxy Job Results  Directory – Hit Enter 

26. Galaxy Client name – Hit Enter 

27. Assign Galaxy Group Permissions – type “no” and hit Enter 

28. Galaxy Firewall Configuration – hit Enter 

29. File copy and service installation status messages will flash on screen.  When done you will see a 
prompt to Hit Enter to continue – Hit Enter 
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30. More status and messages will go by until you are prompted to choose a storage policy from the list – 
Choose the one that corresponds to the library you have configured on the CommCell server (probably 
Option 11 or so) by typing that number in and hitting Enter 

31. More messages and status ending with a Press Enter to Continue – press Enter 

32. At the menu screen, type in “5” (number five) and hit Enter 

33. Cluster Config Screen – Type “3” (Number three) and hit Enter 

34. You will be returned to the prompt – type:  cd /root and hit Enter 

35. Type:  eject /mnt/cdrom and hit Enter 

36. Remove the CD from the system 

37. On the CommCell Console – refresh the client list by hitting the F5 button 

38. Right click on the root of the CommCell Browser tree and choose All Tasks -> Install Updates 

39. You will see a dialog box asking what systems to install the patches on – ensure the “All” checkbox is 
unselected – highlight the name(s) of the ESX server(s) that you have configured with the Linux agent 
and click the arrow to move them to the included list – click OK to start patching the systems  

40. You will see an event in the event viewer that says update installations have started – you will see 
another event when the updates have completed 

41. Once the updates are completed  you are now ready to restore the Virtual Machines as detailed in the 
section on Restoring flat file servers 
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Restoring the flat file servers 
 

Once the CommCell server is fully restored and the iData Agent is installed on the ESX server(s) you can begin 
restoring the flat file servers.  The basic restore steps are the same for all server types you will restore.  After 
the files are restored and the server boots up, there are different steps for some of the different systems that 
are broken out into the subsections before the general restore steps. 

 

Restore the Flat File Disks for the Virtual servers 

The first step to recover the VM servers is to restore the flat file hard drives from each box.  Follow these steps 
to complete the drive restoration: 

1. In the CommCell console, expand the client computers list and find the ESX server that you backed up 
in production – Right click on the server name and choose All Tasks -> Browse and Recover from the 
menu 

2. The Browse Options dialog appears – Change the option for Use Media Agent to engcvm01 from the 
drop down list and click OK 

3. Expand the selections tree out until you find the store that the flat files are on (they will have a .VMDK 
extension) and click on it – NOTE this may take a few moments to populate with data 

4. You will see a number of files in the right hand pane – You will need to define what flat files get 
restored and to where for your environment – the empty chart below can be used or you can 
create your own. 

File Name Contains: Restore to Server: 
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5. For each ESX server’s files follow the steps below to restore the files: 

a. Click on the check box next to the file names as described in the table 

b. Click the Recover All Selected button 

c. The Restore Options Dialog will appear – in the options window make the following changes: 

d. Check the box labeled Unconditional Overwrite 

e. Uncheck the box for Restore to same paths (if Checked) 

f. In the Destination Computer drop down list choose the ESX server you want to restore to 
(Refer to the chart for the recommended locations of the restores) 

g. Click the browse button to locate the restore destination – browse to the vmfs/vmhbaxxxx 
folder and highlight the folder then click OK 

NOTE:  If when you click the browse button, the resulting window will not respond to mouse clicks 
you must reboot the CommServe and return to this step. 

h. Click the Radio Button for “Remove” and in the field next to it, enter the number 2 

i. Click OK to start the restore 

j. The restore job will be submitted and should show up in the job monitor window – you will 
also see the pop-up status bar (in testing this restore took a long time due to tape drive 
speed) 

NOTE: If the job is missing a tape it will prompt you to put it in the library.  Find the tape with the 
proper bar code and put it in the library – Click OK to clear the prompt. 

k. Repeat the steps for all of the restores needed 

Optional - Confirming the file restore has worked – to confirm the restore actually put the files back in 
place you can connect to the VM console through the web browser and log in as root.  Once the console 
opens, click the Manage Files… link in the upper right.  A file browser window will open – expand out the 
file tree under vmfs/your store name and verify that you can see the files that you restored. 

 



Best Practices for Disaster Recovery (DR): Using CommVault QiNetix Software and VMware ESX Server Systems to Rebuild Following a Site-Level Disaster 

 
 

 

 
   

31

“Create” the Restored Servers – ESX Server Web Management Console 

Now that all of the virtual Hard Disk Files have been restored, you can create each of the Virtual servers, and 
point them to the Virtual Drives you just restored. 

1. From the  console on another system, log into the Web Management Console of the ESX server you 
wish to restore the server to (if you have not already) 

2. Click the “Add Virtual Machine” button on the lower right of the page 

3. The Wizard for creating the VM will start – your first option is to choose the OS, display name and 
location – Use the table below as a model for creating your own checklist for entering in the correct 
information for each of the servers to be restored (CAPTIALIZATION MATTERS!!): 

Server 
Name 
(Display 
Name) 

Guest 
Operating 
System 

Location ESX server Host 
Recommended 

Server Restored? 

     

     

     

     

     

     

4. After you click the Next button you will see the Configuration screen – make the changes indicated 
below: 

a. Use this area to define any special configs for certain servers – for example you may 
have a server that needs more RAM or multiple procs – add that information here for 
easy reference 

5. The VM will be created and you will see it appear in the background screen.  The next window will ask 
you what virtual disk file you would like to use.  Click the link for Existing 

6. You will be prompted to choose the VMDK file from the dropdown list – choose the file name that is the 
same as the server you are building and then click Next (You may need to move the window up to see 
the Next Button) 

7. The Server hardware configuration screen will appear.  Find the Network Adapter section and click the 
Edit link next to it. 

8. The Network Adapter Config screen opens – In the Network Connection Dropdown list choose the 
public network interface from the list. – Click OK to close the window 

9. The hardware settings window will display - click on the Red Square next to the Server name in the 
upper left corner – select the Green Triangle from the small menu that appears 

10. Click the close button in the upper right to exit the Hardware settings window 

You should go back and repeat these steps for as many VM boxes as you will be recovering on all of the ESX servers.  
Once completed, follow the individual guides for restoring the individual servers and the post restore steps for each one 
in the sections that follow. 
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Virtual Server Recovery Steps 
 

Active Directory and IP Services  

Domain Controller Post Restore Steps 

In order for the domain to function correctly the Domain Controller must seize the domain control roles 
from the now deceased DC’s that were in the data center.  Follow these steps to complete this task: 

1. From the ESX Web interface, click on the Red Square next to the name of the server and then click the 
Green Triangle in the menu that appears – this will power on the server (This make take a while) 

2. Now find the link at the bottom that says: “Download VMWare Remote Console:” and click the 
Windows link next to it 

3. You will be prompted to save the file and should default to the desktop – click the Save button 

4. The file will download – when it is done, browse to the desktop and double click the file to install the 
client 

5. Welcome screen – click next 

6. License agreement – click “I accept….” Radio button and then click Next 

7. Destination Folder – click Next 

8. Confirm – Click Install 

9. Complete – Click Finish 

10. On the desktop there should be an icon for VMWare remote console - double click it to launch the 
application 

11. The Connect to server prompt will show up – enter in the ESX server hosting the VM you want to access 
– for the username and password use the root account that you set up during ESX installation 

12. A list of the VM’s on the system will appear – highlight the name of the domain controller server that 
you created above and click OK 

13. The console will open and it will look like the regular Remote Desktop screen – under the Power menu 
choose “Send Ctrl-alt-delete to get a login prompt (NOTE:  You may see a message about failed 
services or drivers – this is expected at this point, you can click OK to clear the message) 

14. Log in with the DR User username and password from the DR password list that is in the DR Kit 

15. In the Remote Desktop Shell, click Start -> Programs -> Administrative Tools -> Active Directory Users 
and Computers 

16. When the AD Users and Computers opens, expand the domain tree (if it is not already) and right click 
on the root level of the tree and choose Find.. from the menu 

17. In the Search For field, type in “administrator” and hit enter 

18. you will see the results in the bottom pane – find the one called administrator and right click on it – 
choose Reset Password from the menu 

19. In the new password field just type in “password” twice and hit OK 

20. Confirmation prompt – hit OK 

21. Close the AD Users and computers manager, and log out (not restart) of the system 

22. Log back into the system again, using the administrator account with the password you just set 

1. Right click on Network Neighborhood and choose Properties from the menu 

2. Right click on the connection named Local Area Connection X  - and click properties again 
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3. Highlight the Internet Protocol (TCP/IP) in the configuration menu, and then click the Properties button 

4. The Properties window will open.  Click the radio button next to “Use the Following IP address” in the 
fields enter the following information: 

a. IP Address:  Enter your DR IP Address for the Domain Controller here (NOTE: this should 
most likely match your DNS and WINS addresses that you have used on the other servers) 

b. Subnet Mask: Enter your subnet mask 

c. Default Gateway:  Enter your default gateway 

d. Preferred DNS Server: Enter DNS server – most likely it is the IP address of this server 

e. Secondary DNS Server:  If one is available you can enter it – otherwise leave blank 

5. Click the Advanced button at the bottom right 

6. Click the WINS tab 

7. Click the Add button, and in the Add Wins Server IP field, type in: the IP of the WINS server (most likely 
the IP of the DC itself) and click the Add Button 

8. Click OK to close the advanced settings 

9. Click OK to close the TCP/IP properties window 

10. Click the Checkbox next to “Show Icon in taskbar when connected” and then Click OK 

11. Close the Network Connections window by clicking the “X” in the upper right corner 

23. Back In the Remote Desktop shell, click Start -> run and type in “cmd” in the run line 

24. At the command prompt, type “ntdsutil” and hit Enter 

25. Type “roles” and press Enter 

26. Type “connections” and press Enter 

27. type “connect to server yourservernamehere” and hit enter – You will se a message saying it has 
connected as the local user 

28. At the server connections prompt, type the letter “q” and hit Enter 

29. type the following commands in order: 

a. seize schema master – Hit Enter 

 Prompt to confirm – Click Yes 

b. seize PDC – Hit Enter 

 Prompt to confirm – Click Yes 

c. seize RID master – Hit Enter 

 Prompt to confirm – Click Yes 

 Warning Dialog – Click Yes 

d. seize Domain Naming Master – Hit Enter 

 Prompt to confirm – Click Yes 

e. seize Infrastructure master  – Hit enter 

 Prompt to confirm – Click Yes 

30. type the letter “q” and hit enter 

31. type the letter “q” and hit enter 

32. Back at the command prompt, type “exit” and hit Enter – the command prompt window will close 
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33. Now we must perform some DNS cleanup steps to enable clients to browse the network correctly – to 
access the DNS control panel, click on Start -> Programs -> Administrative Tools -> DNS 

34. The DNS management console will open – expand the server name engdc99 by clicking the + sign 

35. Expand the Forward Lookup Zones by clicking the + sign 

36. Scroll through the list to find your production domain if needed – expand it to reveal the hosts 

37. In the DNS control window, expand out the following path by clicking the + sign: 

a. _msdcs -> pdc -> _tcp 

38. There will be a single entry with the name _ldap – right click on the entry and choose Properties from 
the menu 

39. In the “Host offering this service” field – change the name there to be the FQDN of the domain cotroller 
you are recovering – NOTE VERY IMPORTANT!!! – Include a trailing period at the end of the FQDN so 
that it reads something like PDC01.somedomain.com.  <- just like that!! 

40. Click OK 

41. Back in the DNS control panel -> scroll up to the top level of the tree, and find the server name of the 
DC you are recovering – right click on it and choose:  All tasks -> restart from the menu 

42. You will see the service restart progress bars go by (be patient they may take a minute to restart) 

43. scroll back down to your domain – click on it to display the resource records in the right hand pane 

44. You need to change a number of entries within DNS in order to allow for accurate name resolution for 
users on the internal network – follow the sub-steps here to make the required changes: 

a. Scroll through the resource record list a short way until you see one with a type of Mail 
Exchanger – right click on it and choose properties from the menu 

b. In the “Fully Qualified Domain Name of Mail…” field – change the value to be the FQDN of 
your DR Exchange Server and as before, be sure to include the trailing period! 

c. Click OK 

d. At this point you should also include any IP changes for internal websites, 
application hosts, or any other system that will be changing IP addresses.  Server 
IP’s are not as critical since they will re-register with DNS when they come into the 
domain, but websites will not.  This is part of your discovery process and needs to 
be done WAY before you are trying to rebuild in DR! 

45. Once you are done here – click the X in the upper right to close the DNS control panel 

46. Back at the desktop double click on the clock in the system tray (it is displaying the wrong time and 
probably the wrong date) 

47. When the time and date properties window opens, set the date and time using the window (pretty self-
explanatory how to do this) and then click OK 

48. Reboot the server one final time to ensure all resources are functional 

You have now recovered the Domain Controller and the Windows domain. 
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External Name Services Server Post Restore Steps 

If your company runs its own Start of Authority (SOA) Name Servers it is not possible for any Internet based 
services such as the corporate website or email to function without this server being restored.  Follow the 
steps below to restore name services functionality. 

1. On the desktop of your console system there should be an icon for VMWare remote console - double 
click it to launch the application 

2. The Connect to server prompt will show up – enter in the ESX server hosting the VM you want to access 
– for the username and password use the root account that you set up during ESX installation 

3. A list of the VM’s on the system will appear – highlight the DNS server that you created previously and 
click OK 

4. The console will open and it will look like the regular Remote Desktop screen – under the Power menu 
choose “Send Ctrl-alt-delete to get a login prompt (NOTE:  You may see a message about failed 
services or drivers – this is expected at this point, you can click OK to clear the message) 

5. Log in with the DR User username and password from the DR password list 

6. Right click on Network Neighborhood (My Network Places) and choose Properties from the menu 

7. Right click on the connection named Local Area Connection X  - and click properties again 

8. Highlight the Internet Protocol (TCP/IP) in the configuration menu, and then click the Properties button 

9. The Properties window will open.  Click the radio button next to “Use the Following IP address” in the 
fields enter the following information: 

a. IP Address:  Enter your DR IP Address for the DNS Server here 

b. Subnet Mask: Enter your subnet mask 

c. Default Gateway:  Enter your default gateway 

d. Preferred DNS Server: Enter DNS server IP – most likely it is the IP address of this server 

e. Secondary DNS Server:  If one is available you can enter it – otherwise leave blank 

10. Click OK to close the Window 

11. Back at the desktop click Start -> All Programs -> Administrative Tools -> DNS 

12. The DNS Control Panel will open – Click on the + sign to expand the tree through DNSSERVERNAME --> 
Forward Lookup Zones -> YourDomainName 

13. Click on the zone to reveal the Resource records it holds in the right hand pane.   

14. You will see two records with a type of Name Server (NS) – follow these steps to reset the NS records: 

a. Right click on the first record – choose Properties from the menu 

b. You will see the two servers listed in the pop-up window – highlight the first one 

c. Click the Edit Button 

d. In the name field change the server name to match the name of your DR DNS server 

e. Click on the listed IP address and click the Remove button 

f. In the IP address field type in the IP address given to you by the network team for the Name 
Server IP address NOTE: The chart on the next page has a place for you to write this value, 
and a value you must supply to them as well. 

g. Click the Add button 

h. Click OK 

i. Highlight the second NS record and repeat the process using the SAME IP that you used in the 
step above. 



Best Practices for Disaster Recovery (DR): Using CommVault QiNetix Software and VMware ESX Server Systems to Rebuild Following a Site-Level Disaster 

 
 

 

 
   

36

j. Once you are back at the main properties window – click OK to close it 

15. Back at the DNS control panel main console – make sure the zone is still highlighted 

16. Using the chart below change the indicated entries to match the IP addresses given to you by the 
Network DR team by following the steps below the chart: 

At this point you should fill in the chart below with the host list of external systems you need to Re-
IP.  If you have a BGP scenario in place you may not need new external IP’s, but chances are your 
internal IP scheme will have changed somewhat so the network team will need new internal ones to 
change the port mappings on whatever firewall they are setting up. 

DNS Name (In DNS Manager list) Internal System IP address 
(give this to the network 
team) 

External IP address (from 
Network Team) 

   

   

   

   

   

   

   

   

   

   

   

   

 

a. Right click on the record you want to change (as listed in the chart above) – choose Properties 

b. In the IP address field change the value to the IP address given to you by the network team – 
NOT THE ONE ALREADY LISTED IN THE CHART!  That IP is for them to create the firewall 
translations with and you need to share this list with them to get your IP addresses 

c. Click OK 

d. Repeat for all of the listed entries 

17. Once you have completed these steps you can close the DNS manager and proceed on to restoring 
services 

NOTE:  Someone will need to update the DNS registrar’s records with the IP address of the Name Server 
record.  This will probably have to be done by an officer of the company.  If any information is available it will 
be in the DR kit, otherwise the Network Team should manage this change. 
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Exchange Services – SMTP Gateway and Mailbox Server(s) 

External SMTP Gateway Server 

SMTP Services Post Restore Steps 

NOTE:  if all other exchange servers are not operational (mailboxes need not be connected) you must pause at 
this time. 

1. On the desktop there should be an icon for VMWare remote console - double click it to launch the 
application 

2. The Connect to server prompt will show up – enter in the ESX server hosting the VM you want to access 
– for the username and password use the root account that you set up during ESX installation 

3. A list of the VM’s on the system will appear – highlight your SMTP gateway server and click OK 

4. The console will open and it will look like the regular Remote Desktop screen – under the Power menu 
choose “Send Ctrl-alt-delete to get a login prompt 

5. Log into the server with the Local Administrator account from the Password list ( you will most likely 
get the “some services did not start” message – this is expected click OK to clear the message) 

NOTE – if you are prompted about newly discovered hardware continue through the prompts in 
the affirmative always, but DO NOT REBOOT until they are all done installing then REBOOT and 
resume from step 1 

6. Right click on Network Neighborhood (My Network Places) and choose Properties from the menu 

7. Right click on the connection named Local Area Connection X  - and click properties again 

8. Highlight the Internet Protocol (TCP/IP) in the configuration menu, and then click the Properties button 

9. The Properties window will open.  Click the radio button next to “Use the Following IP address” in the 
fields enter the following information: 

a. IP Address:  Enter your DR IP Address for the Server here 

b. Subnet Mask: Enter your subnet mask 

c. Default Gateway:  Enter your default gateway 

d. Preferred DNS Server: Enter DNS server IP 

e. Secondary DNS Server:  If one is available you can enter it – otherwise leave blank 

10. Click the Advanced button at the bottom right 

11. Click the WINS tab 

12. Click the Add button, and in the Add Wins Server IP field, type in your WINS server IP and click the Add 
Button 

13. Click OK to close the advanced settings 

14. Click OK to close the TCP/IP properties window 

15. Click the Checkbox next to “Show Icon in taskbar when connected” and then Click OK 

16. Close the Network Connections window by clicking the “X” in the upper right corner 

17. Reboot the server 

18. Log back into the server this time using the Domain Administrator account and password 

19. At this point you should include whatever steps are needed to reconfigure ani anti-virus 
products that may be installed 

NOTE:  It is a good idea to queue mail so that mail is being accepted, but is storing itself on the mail server.  
Time is of the essence at this point to get the mailboxes reconnected. 
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Mailbox Server(s) - follow instructions for as many mailbox hosts as you plan to bring up 

Mailbox Server Post Restore Steps 

Now that the Exchange server is operational, follow these steps to begin mailbox recovery on the system. 

1. From the ESX Web interface, click on the Red Square next to the name of the server and then click the 
Green Triangle in the menu that appears – this will power on the server 

2. On the desktop of the system there should be an icon for VMWare remote console - double click it to 
launch the application 

3. The Connect to server prompt will show up – enter in the ESX server hosting the VM you want to access 
– for the username and password use the root account that you set up during ESX installation 

4. A list of the VM’s on the system will appear – highlight the name of your mailbox server and click OK 

5. The console will open and it will look like the regular Remote Desktop screen – under the Power menu 
choose “Send Ctrl-alt-delete to get a login prompt 

6. Log into the server using the local administrator account username and password contained in the 
Password list ( you will most likely get the “some services did not start” message – this is expected 
click OK to clear the message) 

7. Right click on Network Neighborhood and choose Properties from the menu 

8. Right click on the connection named Local Area Connection X  - and click properties again 

9. Highlight the Internet Protocol (TCP/IP) in the configuration menu, and then click the Properties button 

10. The Properties window will open.  Click the radio button next to “Use the Following IP address” in the 
fields enter the following information: 

a. IP Address:  Enter your DR IP Address for the Server here 

b. Subnet Mask: Enter your subnet mask 

c. Default Gateway:  Enter your default gateway 

d. Preferred DNS Server: Enter DNS server IP 

e. Secondary DNS Server:  If one is available you can enter it – otherwise leave blank 

11. Click the Advanced button at the bottom right 

12. Click the WINS tab 

13. Click the Add button, and in the Add Wins Server IP field, type in the IP of the WINS server and click the 
Add Button 

14. Click OK to close the advanced settings 

15. Click OK to close the TCP/IP properties window 

16. Click the Checkbox next to “Show Icon in taskbar when connected” and then Click OK 

17. Close the Network Connections window by clicking the “X” in the upper right corner 

18. Reboot the server 

19. Your next step here is to verify that the Microsoft Exchange services has started correctly – right click 
on my computer and choose Manage from the menu 

20. The Computer Management screen will open and you will have a tree of options – Expand the Services 
and Applications option by clicking the + sign 

21. Click on the Services area and the right side will display a list of the services on the system 

22. Scroll the list to find the ones that begin with “Microsoft Exchange …” – arrange your view so you can 
display the column for Startup Type and Status  -  Exchange is most likely fairly pissed off right now 
since all of the other servers in the site are gone but the services should all be started. 
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23. Before you begin any reconfiguration you need to match up to the domain controller’s time and date 
settings – click on Start -> Run 

24. In the run window, type in cmd and hit enter 

25. In the command prompt – type the command:  net time /set  

26. You will be prompted to set the time to match your DC – hit enter 

27. Type exit to close the command prompt and reboot the server 

Exchange Cleanup Steps 

1. Back at the desktop go to Start -> All Programs -> Microsoft Exchange -> System Manager 

2. The System Manager will open 

3. Expand the following tree path -> Administrative Group -> First Administrative Group -> Routing 
Groups -> YOURSITENAME -> Members 

4. Highlight the name of the Exchange Server in the list and right click on it – choose Set as master from 
the menu 

5. Click on the Connectors object that is right above the members object 

6. In the right hand pane of the window right click on the “SMTP Outbound Connector” and choose 
Properties from the menu 

7. In the “Local Bridgeheads” field – click to highlight the existing bridgehead server – Then click Remove 

8. Click the Add button and find your DR server in the list– click on it to Select it then click OK 

9. Click OK to commit the changes 

10. Expand the following tree path -> Administrative Group -> First Administrative Group -> Servers -> 
Your DR server -> Protocols - click on SMTP in the list 

11. In the right hand pane you will see Default SMTP Virtual Server – right click on it and choose properties 
from the menu 

12. Click the Access tab 

13. Click the Relay button 

14. Click the Add button 

15. Click the radio button for “Group of computers” 

16. In the IP address and subnet mask fields enter the IP range of your DR environment and its subnet 
mask 

17. Click OK 

18. Click OK again 

19. Click OK one last time to complete the changes 

20. Now expand the Recipients area and click on Recipient Update Services 

21. In the right hand pane you will see the available Recipient Update Services – repeat the following 
steps for ALL services in the window: 

a. Right click on the service and choose properties from the menu (NOTE this will take a second 
to open as it is currently looking for non-existent servers) 

b. Next to the field for Windows 2000 Domain Controller – click browse 

c. Find your DR Domain Controller in the list and double click the server name 

d. You will be returned to the Properties window and the domain controller field shows the new 
server name 

e. Click the browse button next to the Exchange Server field 
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f. Find your main DR Exchange Server in the list and double click the server name 

g. You will be returned to the Properties window and the field shows the new exchange server 
name 

h. Click Apply -> then click OK to close 

i. Repeat for the other services that are present 

22. Once you have completed these changes – shutdown the server (NOT reboot!) 

23. Log into the ESX Management web page using the web browser as you have done before 

24. In the management window, click the name of the exchange server (make sure it has a red square 
beside it before you do this!) 

25. The VM configuration window will open – click the hardware tab 

26. at the bottom of the Hardware display, click the Add Device link 

27. In the Add Device window, click the link for Hard Disk 

28. Click the link for blank to create a new drive 

29. In the “Edit Virtual Disk Configuration” window change the following options: 

j. The Image File name – change untitled.vmdk to be servername_data.vmdk 

k. Change the capacity to be large enough to hold your information stores 

l. Leave all other options alone and click OK 

30. Back in the Hardware Configuration screen – click the Close link in the upper right of the window 

31. Back at the ESX management screen, click the red square next to the Exchange server and in the little 
menu that pops up, click on the green triangle to power the server back on 

32. Reconnect the remote desktop session or VMWare console to the server once it is powered back up 

33. On the desktop of the server – right click on the My Computer icon and choose manage from the menu 

34. in the Computer Manager tree, find the folder labeled Disk Management and click to highlight it 

35. You will start the Signature and Upgrade wizard – click Next 

36. in the Select disk to write signature window - click the box next to Disk 1 then click Next 

37. In the Upgrade disk window – UNCHECK the box next to Disk 1 and click Next 

38. Click Finish to complete the wizard 

39. In the Disk Management window you should see a Drive labeled Disk 1 with the words: 100.00 GB 
Unallocated next to it in a black outlined box – right click in the box area and choose Create Partition … 
from the menu 

40. Welcome screen – click Next 

41. Partition Type screen – click Next 

42. Specify Size – click Next 

43. Assign Drive Letter – click Next 

44. Format Partition – IN the volume label field, type:  Data  -  click the check box next to “Perform a Quick 
Format” and then click Next 

45. Confirmation summary – click Finish 

46. The partition will format and display in the disk manager window 

47. Close the Computer Manager window 

48. Go to Start -> All Programs -> Microsoft Exchange -> System Manager 
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49. The System Manager will open 

50. Expand the following tree path -> Administrative Group -> First Administrative Group -> Servers -> 
YourExchangeServerName 

51. Repeat the following steps for all Stores: (Capitals Matter!) 

• At this point you need to include a list of the store names from your production 
server – IS restores can be redirected to a new server name, but the Store name 
must be 100% the same as it was in production 

a. Right click on the First Storage Group and choose New -> Mailbox Store… from the menu 

b. In the Name Field – type in the name of the store from the list above 

c. Click on the Database Tab 

d. In the two path fields for Exchange Database and Exchange Streaming Database, change the 
first part of the path to be “Data Drive Letter:\mdbdata\prepopulated filename”  

e. Click the Checkbox next to “This database can be overwritten by a restore” and then click OK 

f. Confirm Store Creation – Click No 

g. Repeat for the remaining stores 

Once all of the stores are created, you will need to restore the data from the CommCell 

Exchange Information Store Recovery Steps 

1. Log into the Exchange VM using the exchange restore credentials on the Password List in the DR Kit 

2. Insert the CD labeled CommVault Install Disk 1 into the ESX server that is hosting this exchange server 

NOTE:  If setup does not Auto Run refer to the section in the troubleshooting Appendix regarding 
connecting a CD Rom drive to a VM server 

3. Language Selection – click Next 

4. Click the link that says – “install QiNetix Software on this computer” 

5. Welcome – click Next 

6. Anti virus prompt – click OK 

7. License Agreement – click the radio button for “I accept….” Then click Next 

8. Select Platforms – expand the iData Agents selections and click on the iDA for Windows 2000 

9. Expand the Exchange iData Agents – Select ALL of the checkboxes except Web Folders and then click 
Next 

10. Installer rights prompt – click Yes 

11. Destination Folder – click Next 

12. CommServe Host Name – type in the name of your CommServe and hit Next 

13. Communication interface – hit Next 

14. Job Results path – click Next 

15. Firewall Configuration – click Next 

16. Summary – click Next 

17. Installer prompt – security rights – Click the Log Off button 

18. The system will log you off, and if you are in an RDP session it will disconnect you.  Reconnect and log 
back in with the same account you used to start the setup – setup will resume 

19. Storage Policy selection – choose any existing policy and click Next 

20. Storage Policy selection – choose any existing policy and click Next 
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21. Exchange Backup options – click Next 

22. CommVault Install prompt concerning circular logging – click OK 

23. Storage Policy selection – choose any existing policy and click Next 

24. Exchange Administrator Account Information – enter the following values: 

a. Account name:  Account needs to be the same as the one you are logged in as 

b. Account password: refer to password list 

c. Mailbox Name: Fills in automatically 

d. Profile Name:  DR 

e. Exchange Server Name:  Leave default 

f. Domain:  Leave default 

25. Click Next 

26. Storage Policy:  Leave default and Click Next 

27. Exchange Administrator Account Information (NOTE:  This is the same information for a different 
reason then the step above) – enter the following values: 

a. Account name:  Account needs to be the same as the one you are logged in as 

b. Account password: refer to password list 

c. Mailbox Name: Fills in automatically 

d. Profile Name:  DR 

e. Exchange Server Name:  Leave default 

f. Domain:  Leave default 

28. Click Next 

29. Storage Policy:  Leave default and Click Next 

30. Installation Summary – Click Next 

31. Setup Complete – click Finish 

32. In the CommCell Browser – highlight the client list header and hit F5 

33. Scroll down to the name of the Exchange server you just installed and right click on it -> choose Install 
Updates from the menu 

34. You will see a notification of the installation beginning in the event viewer pane – when it tells you that 
installation is completed in the event pane you can proceed 

35. Right click on the production server that you want to restore data from and choose Browse and 
Recover from the menu 

36. Change the Use Media Agent to the CommCell in your DR environment  

37. Click OK 

38. The Browse Window will open – click the + sign next to Exchange Database and continue drilling down 
until you see First Storage Group – click on it to highlight it 

39. The available files will appear in the right hand window – click on the checkbox next to all of them 
except the last one (Public Folder Store) 

40. Click Recover All Selected 

41. Restore Options Dialog box make the following settings changes: 

a. Check radio box next to Restore to a Different Client and choose the server you restored into 
the DR environment from the list 
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42. Click OK to begin the restore process 

43. The restore job will be submitted and you can take a deep breath, because this will take a while 

Once the restore completes move on to section 7.2.3 – Exchange Post Information Store Restore Steps 

NOTE – if you are recovering more than one Exchange Server you should add as many sections as needed 
for the recovery.  The only steps that need not be performed on subsequent exchange server recoveries 
are the ones in section 7.2.2.2 step numbers 1 through 21 

 

Exchange Post Information Store Recovery Steps 

“Delete” Mailboxes 

Now that all of the information stores are restored and running, you must perform the incredibly tedious and 
time consuming task of reconnecting all the user mailboxes.  The first part of this is to “delete” – really this 
only means disconnecting – the user mailboxes. 

NOTE:  To increase the speed of this, it is recommended to run this in parallel from as many exchange servers 
as you have available.  Split up the list accordingly, and execute the steps to cut down on the time to “delete” 
all the mailboxes. 

1. From either of the Exchange server consoles (access using the VMWare Console utility) click Start -> 
Programs -> Microsoft Exchange -> Active Directory Users and Computers 

2. The management screen will open.  Choose View -> Filter Options from the menu 

3. In the Filter Options menu, change the number at the bottom of the window to read “5000” and then 
click OK 

4. Now, back in the main window, expand the first level of the Active Directory (AD) tree by clicking the + 
sign next to the domain name of your production domain 

5. In the list you will see a number of folders – repeat the following steps for any folder that have mail 
enabled accounts in them: (The chart below is to server as a place for you to list any OU’s that 
have mail-enabled accounts in them – do not overlook service accounts!!) 

Folder (OU) Subfolders (Containers) 

  

  

  

  

  

 

a. First expand each top level folder as listed on the left of the chart by clicking the + sign 

b. Click to highlight the indicated subfolder 

c. In the right-hand pane the list of users will appear 

d. Click on any user name, and then hold down the ctrl key and press “a” – this will select all 
listed users 

e. Right click on any name again, and choose “Exchange Tasks” from the menu 

f. In the pop-up choose the “Delete Mailbox” option and click Next 
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g. Mailbox Deletion warning – click Next 

h. Mailbox Deletion progress meter – this will take a significant amount of time (up to 60 
seconds per account with a mailbox) 

i. Repeat this step for all of the indicated folders in the table 

6. Once all the mailboxes have been “deleted” you are now ready to reconnect all the mailboxes 

Reconnect all Mailboxes 

Once all mailboxes are deleted you can begin the process of reconnecting them.  Repeat all of the steps for any 
DR Exchange mailbox servers 

1. Browse to the MBConn directory on the Tools CD 

2. Copy the 2 files there to the root of the C Drive 

3. Browse to the root of C and double click the MBConn executable to launch the program 

4. Welcome screen – click Next 

5. Server Selection screen – enter the name of the exchange server and the domain controller – then click 
next 

6. A list of the stores will appear – click the Select All button on the right and then click Finish 

7. The Mailbox Reconnect window will open and after a bit will populate with all of the mailboxes – from 
the menu click the Preview All Button (Looks like a magnifying glass with a checkmark)  

8. Browse for container will appear - click OK 

9. It will process the list of mailboxes and find matching AD accounts for them – when it is done running 
through the list choose Actions -> Apply from the menu 

10. Are you sure prompt – click Yes 

11. Again it will process the list and make the requested changes – when completed a summary will 
appear (There will most likely be a few failed mailboxes - see the troubleshooting appendix on what to 
do in the event of failures to reconnect mailboxes) – Click OK to close the confirmation 

12. The list should refresh and go blank. 

13. Repeat the same steps for the other Exchange server 

14. Close the MBConn tool 

You can now rebuild the recipient update service and proceed to testing. 

Rebuild the Recipient Update Service 

1. On either of the Exchange server consoles – click Start -> Programs -> Microsoft Exchange -> System 
Manager 

2. System Manager opens 

3. Expand the Recipients section and click on the Recipient Update Services section 

4. Right click on the “Recipient Update Service(yourExchangeSiteName)” in the right hand pane and 
choose Rebuild from the menu 

5. Prompt Concerning this taking a LONG time – click Yes (this seriously could take an hour or more) 

You are pretty much done here with the Exchange rebuild.  You will need to test, but until the RUS rebuild 
is done you will not have much luck.  To see if the RUS rebuild is working you can go into click Start -> 
Programs -> Microsoft Exchange -> Active Directory Users and Computers and look at the email address 
fields under any of the user accounts.  If it has an email address there, then it is fixed. 
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Web and Application Services – This may or may not be needed for your environment 

IIS Website Server 

Website Server Configuration Steps 

After you have restored and powered on the server follow these steps to recover the websites on the server: 

1. On the desktop of your system there should be an icon for VMWare remote console - double click it to 
launch the application 

2. The Connect to server prompt will show up – enter in the ESX server hosting the VM you want to access 
– for the username and password use the root account that you set up during ESX installation 

3. A list of the VM’s on the system will appear – highlight the name of your DR webserver and click OK 

4. The console will open and it will look like the regular Remote Desktop screen – under the Power menu 
choose “Send Ctrl-alt-delete to get a login prompt 

5. Log in with the DR User username and password from the DR password list 

6. Click on Start -> Control Panel – right click on Network Connections in the list and choose Open from 
the menu 

1. Right click on the connection named Local Area Connection X  - and click properties again 

2. Highlight the Internet Protocol (TCP/IP) in the configuration menu, and then click the Properties button 

3. The Properties window will open.  Click the radio button next to “Use the Following IP address” in the 
fields enter the following information: 

a. IP Address:  Enter your DR IP Address for the web server here 

b. Subnet Mask: Enter your subnet mask 

c. Default Gateway:  Enter your default gateway 

d. Preferred DNS Server: Enter DNS server IP 

e. Secondary DNS Server:  If one is available you can enter it – otherwise leave blank 

4. Click the Advanced button at the bottom right 

5. Repeat the following steps for the indicated IP addresses: 

a. Click the Add button below the IP addresses field 

b. Enter the IP/Subnet Mask combination as indicated here: You need to fill in the table that 
follows with the additional IP’s that will be needed to host as many websites as you are 
recovering to this server. 

Website URL IP Address Subnet Mask 

   

   

   

   

   

 

c. Click Add - repeat for each of the IP’s in the table 
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6. Click the WINS tab 

7. Click the Add button, and in the Add Wins Server IP field, type in your WINS server IP and click the Add 
Button 

8. Click OK to close the advanced settings 

9. Click OK to close the TCP/IP properties window 

10. Click the Checkbox next to “Show Icon in taskbar when connected” and then Click OK 

11. Close the Network Connections window by clicking the “X” in the upper right corner 

Reconfigure IIS websites 

Now that you have assigned the IP address you can reconfigure the websites that need to be up and running. 

1. Back at the desktop – Click on Start -> Administrative Tools -> Internet Information Services (IIS) 
Manager 

2. The IIS administration console will open – drill down the console tree by clicking the + sign until you 
can see The Web Sites container 

3. Click on the Websites container to view the websites on the server – they should show up in the right 
hand pane and most of them should be stopped 

4. Repeat the following steps for all of the websites you are recovering: 

a. Right click on the website – choose properties from the menu 

b. In the properties window – click the Advanced tab 

c. In the top of the advanced properties window you will see a list of the aliases of this website.  
Follow the steps below for all of the listed aliases: 

i. Highlight the alias – click Edit 

ii. From the IP Address drop down – choose the IP address to bind the site to (refer to 
the chart above for the URL to IP matching) 

iii. Click OK 

iv. Repeat for the remaining aliases 

d. Once you have changed all of the site aliases – click OK to close the advanced properties 
editor 

e. Click OK again to apply the changes and close the properties window 

f. Now right click on the site name again – Choose Start from the menu – The state should 
change to “Running” 

5. Right click on any remaining websites – choose STOP from the menu (if they are not already stopped) 

6. Once completed you can close the IIS manager console 

You have reconfigured all that needs to be done on this server. 

 

Application Servers 

These systems should pretty much be clones of your existing application servers that you have P2V-d into he 
virtual space and backed up as a flat file.  The basic restore starts the same as all the others – log in, re-IP, etc.  
The final step is to restore data from the CommServe to “catch up” any changes since the image was taken and 
the event that has you recovering. 

Since there is no possible way for me to know what you have in your environment, this one is all you! 
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Rebuilding a SQL Database Server  
 

Install Windows Server 2003 

Follow these steps to install Windows 2003 server on the SQL Server that you identified in Step 3 

1. Verify that there is tape drive hooked up to the server identified from step 3 

2. Insert the Windows Server 2003 CD into the server, and power on the machine 

3. The server will boot from the CD and begin Windows 2003 setup 

4. Eventually you will see a welcome to windows setup text screen with 3 options – Hit ENTER to continue 
with setup 

5. Windows Licensing Agreement screen – hit F8 to continue 

6. Partition selection screen – you should see something similar to this: 

40000 MB Disk 0 at Id0 on bus 0 on … 

 Partition1 (EISA Utilities)… 

 Unpartitioned Space 

 Highlight the Unpartitioned Space and hit C 

NOTE:  If you get an error about no hard-drives found refer to the troubleshooting appendix about 
loading 3rd party drivers during setup 

7. Create Partition of size – change the prepopulated value to 8192 and hit Enter 

8. Back at the partition selection screen highlight the partition you just created and then hit enter 

9. Format Partition Option – select Format the partition using the NTFS file system (Quick) and hit enter 

10. Formatting progress bar will appear – it should go pretty quickly 

11. A file copy progress bar will appear and copy the Windows Server files 

12. The system will confirm all files copied and reboot automatically – when it comes back up it will 
perform some further file copies and go into a more GUI based setup. 

13. The first GUI setup prompt is for the language and region options – Click Next 

14. Name and organization – type whatever you want into both fields and click Next 

15. Volume License Key – Enter the key found on the Serial Numbers list and click Next 

16. Licensing Mode – Click Per user Radio Button and then click Next 

17. Computer Name – Enter the name of the server 

18. Administrator Password – enter the admin password on the DR password list from the DR box and then 
click Next 

19. Date and Time Settings – set the correct date, time and Time Zone and click Next 

20. Installing Network will appear on the left side of the screen with a progress bar.  When the progress 
bar is gone you will see the Network Settings Window – Click Next to continue (you will change these 
settings later after setup completes) 

21. Workgroup or Computer Domain screen – leave defaults and click Next 

22. Now pretty much you get to sit and watch for about 20-30 minutes while setup completes.  Take a 
deep breath and go grab a soda or use the bathroom 

23. The server will reboot once all of the setup tasks are completed.  When it returns to the login prompt, 
log in to the server using the admin password you entered above from the DR password list 
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24. Once the login is completed you will see the “Manage your Server” screen – you can close this and go 
to Start -> Control Panel -> Network Connections Right click on the network connections and choose 
Open from the menu 

25. Right click on the connection named Local Area Connection and click properties 

26. Click the Configure button 

27. Click the Advanced tab 

28. In the Property list you should see something equivalent to Link Speed/Duplex Mode or Media Type – 
click on it to highlight it 

29. In the drop down to the right choose the option that is closest to:  100 Full 

30. Click OK 

31. This will close the properties window - Right click on the connection named Local Area Connection and 
click properties again 

32. Highlight the Internet Protocol (TCP/IP) in the configuration menu, and then click the properties button 

33. The Properties window will open.  Click the radio button next to “Use the Following IP address” in the 
fields enter the following information: 

o IP Address:  Enter your DR IP Address for the Server here  

o Subnet Mask: Enter your subnet mask 

o Default Gateway:  Enter your default gateway 

o Preferred DNS Server: Enter DNS Server IP 

o Secondary DNS Server:  If one is available you can enter it – otherwise leave blank 

34. Click the Advanced button at the bottom right 

35. Click the WINS tab 

36. Click the Add button, and in the Add Wins Server IP field, type in the IP of your WINS server and click 
the Add Button 

37. Click OK to close the advanced settings 

38. Click OK to close the TCP/IP properties window 

39. Click the Checkbox next to “Show Icon in taskbar when connected” and then Click OK 

40. Back at the desktop click on Start -> and right click on My computer – select manage from the menu 

41. In the Computer Manager tree, find the section labeled Disk Management and click to highlight it 

42. In the Disk Management window you should see a Drive labeled Disk 0 with the words: (+/-) 350.00 
GB (essentially composed of everything left on the drive minus the 8 gig OS partition) and Unallocated 
next to it in a black outlined box – right click in the box area and choose Create Partition … from the 
menu 

43. Welcome screen – click Next 

44. Partition Type screen – click Next 

45. Specify Size – click Next 

46. Assign Drive Letter – Change to “S” and click Next 

47. Format Partition options: 

a. Change the Allocation Size from Default to 64k  

b. In the volume label field, type:  SQL Data 

c. Click the check box next to “Perform a Quick Format” - then click Next 
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48. Confirmation summary – click Finish 

49. The partition will format and display in the disk manager window 

50. Close the Computer Manager window 

NOTE – if the recovery of the Domain Controller is not complete then you must pause here before 
continuing.  Once the restoration of that server is done, reboot this server and continue from the next step. 

51. Back at the desktop – right click on My Computer and choose Properties from the menu 

52. click the Computer Name tab 

53. click the Change button 

54. Click the radio button next to the word Domain and in the text field type in the domain name – click OK 

55. Enter password prompt – enter in the administrator name and password as:  
YOURDOMAIN\administrator and the password – click OK 

56. Domain confirmation – click OK 

57. You must reboot prompt – click OK 

58. System Properties – click OK to close 

59. System Settings Change prompt – click Yes to reboot 

60. Once the server is rebooted you are ready to install SQL server 

 

Install SQL Server 2000 and SP4 

Install SQL Server 2000 

1. Locate the SQL 2000/Winzip CD from the DR Kit 

2. Once you have logged back into the server (make sure to log into the Domain and not just the local 
server – you can verify this by clicking the Options button at the login screen, and making sure the 
domain shows up instead of the computer name) – insert the CD and browse to the CDROM drive 

3. under the SQL2000 folder, drill down to the x86\setup directory and double click the setupsql.exe file 

4. SQL server setup prompt about compatibility – click Continue (you will patch after the install) 

5. Welcome – click next 

6. Computer Name – click Next 

7. Installation Selection -> click next 

8. User information – click next 

9. License agreement – click Yes 

10. Installation Definition – click Next 

11. Instance Name – click Next 

12. Setup Type – click the Browse button next to Data Files 

13. Choose Folder box – Type in “S:\” and hit OK 

14. Back at the Setup Type Screen – click Next 

15. Service Account – click the radio button for “Use Local System” – click Next 

16. Authentication Mode – click the radio button for Mixed Mode – in the sa password field enter the 
disaster recovery SA password from the password list 

17. Confirmation – click Next 
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18. Licensing Mode – click Processor License and change the number to 2 – then click Continue 

19. Setup will now run and copy files and start the SQL server 

20. When it is completed click Finish to exit 

Install SQL Server SP4 

21. On the SQL 200/Winzip CD browse to the root and double click the SQL2kSP4 file 

22. Installation folder prompt – click Finish and the files will be unpacked 

23. Package delivered confirmation – click OK 

24. Back at the CD Rom drive root – browse to c:\sql2ksp3a\x86\setup and double click the setupsql.exe 
file 

25. Welcome Screen – click Next 

26. License Agreement – click Yes 

27. Instance name – Click Next 

28. Connect to Server – click Next 

29. Compatibility check list – click the check box next to Upgrade Microsoft Search and….. then click 
Continue 

30. Error Reporting – click OK 

31. Start Copying Files – Click Next 

32. When this portion is completed you will see a prompt to backup the master and msdb databases – 
click OK 

33. Setup Complete – click Finish 

34. Reboot the server 

 

Install CommVault Agent and Restore Databases 

Install CommVault 

1. Insert the CD labeled CommVault Install Disk 1 into the SQL server 

2. Language Selection – click Next 

3. Click the link that says – “install QiNetix Software on this computer” 

4. Welcome – click Next 

5. Anti virus prompt – click OK 

6. License Agreement – click the radio button for “I accept….” Then click Next 

7. Select Platforms – expand the iData Agents selections and click on the iDA for Windows Server 2003 

8. Expand the Database Agents – Select the check box for iDA for SQL Server - click Next 

9. Installer rights prompt – click Yes 

10. Destination Folder – click Next 

11. CommServe Host Name – type in the name of your CommServe and hit Next 

12. Communication interface – hit Next 

13. Job Results path – click Next 

14. Firewall Configuration – click Next 
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15. Summary – click Next 

16. Installer prompt – security rights – Click the Log Off button 

17. The system will log you off.  Log back in with the same account you used to start the setup – setup will 
resume 

18. Storage Policy selection – choose any of them and click Next 

19. MSSQL configuration Wizard – Highlight the SQL instance and click Configure 

20. Storage Policy Prompt – click Next 

21. Account name -> use the DR SQL backup Account from the DR password list – click Next 

22. SQL Undo Path – in the field type in S:\ and click Next 

23. SQL Config Wizard – click Next 

24. Prompt concerning databases – click Yes 

25. Confirmation of configuration - click Finish 

26. Permissions assigned prompt – click No 

27. Schedule Reminder – click Next 

28. Completion Report – click Finish 

29. Now, go to the CommCell Machine Console and log into the CommCell console 

30. In the CommCell Browser – highlight the client list header and hit F5 

31. Scroll down to the name of the SQL server you just installed and right click on it -> choose Install 
Updates from the menu 

32. You will see a notification of the installation beginning in the event viewer pane – when it tells you that 
installation is completed in the event pane you can proceed 

Restore SQL Databases 

1. In the CommCell Browser window, expand the client list and find the server that housed the SQL 
databases you want back – expand it by clicking the + sign 

2. Right click on the SQL Server 2000 iDA and choose Browse SQL Server from the menu 

3. In the Browse options window click OK 

4. Expand the tree to view the databases that are available 

NOTE: You do not need to restore all of them at this time, but you can restore any that are part of 
your DR plan 

5. Highlight the databases for restore by clicking the box next to them 

6. Click the Recover All selected button to bring up the restore options dialog window 

7. In the restore options dialog box, you need to check the boxes next to “Point in Time” and 
“Unconditionally overwrite existing databases or files” – then click Advanced 

8. You will see a list of the databases and the associated files – in the list you need to change any paths 
that are not pointing to the S:\ drive by modifying the beginning of the path statement to make sure 
that all files point to the S:\ drive 

9. Click OK to close the advanced options 

10. Click OK to start the restore process 

11. Warning prompt – click OK 

NOTE - if prompted to insert a tape into the library find the tape and put it in the library 

12. The restore will run – when it is completed return to the CommCell Browser window 
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13. In the CommCell Browser window, expand the client list and find ENGHR05 and expand it by clicking 
the + sign 

14. Right click on the SQL Server 2000 iDA and choose Browse SQL Server from the menu 

15. In the Browse options window click OK 

16. Expand the tree to view the databases that are available 

a. You only need to check the boxes next to the databases that begin with CESGL and VHR_ 

17. Highlight the databases for restore by clicking the box next to them 

18. Click the Recover All selected button to bring up the restore options dialog window 

19. In the restore options dialog box, you need to check the boxes next to “Point in Time” and 
“Unconditionally overwrite existing databases or files” – then click Advanced 

20. You will see a list of the databases and the associated files – in the list you need to change any paths 
that are not pointing to the S:\ drive by modifying the beginning of the path statement to make sure 
that all files point to the S:\ drive 

21. Click OK to close the advanced options 

22. Click OK to start the restore process 

23. Warning prompt – click OK 

NOTE  -  if prompted to insert a tape into the library find the tape and put it in the library 

24. The restore will run – when it is completed return to the server console 

 

Validate Restored Databases 

Well, another one of those sections that is pretty much up to you – a basic check for restoration success is to 
simply open enterprise manager and see if the databases are there and you can expand them out.  You can 
right click on any table and open it to see if it returns data.  Beyond that you will need to ID what application 
used that DB and if it is recovered OK. 
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Rebuilding a Peoplesoft Database Server on MSSQL  
 

Peoplesoft is its own animal and as such, if you are running a PS shop on MS SQL then you WILL need a 
physically separate server to run its DB on.  These steps will help you through the recovery process for a PS DB 
on SQL.  They have been tested against Peoplesoft 8 

 

Install Windows Server 2003 

Follow these steps to install Windows 2003 server on the Peoplesoft SQL server machine: 

1. Verify that there is tape drive hooked up to the server identified from step 3 

2. Insert the Windows Server 2003 CD into the server, and power on the machine 

3. The server will boot from the CD and begin Windows 2003 setup 

4. Eventually you will see a welcome to windows setup text screen with 3 options – Hit ENTER to continue 
with setup 

5. Windows Licensing Agreement screen – hit F8 to continue 

6. Partition selection screen – you should see something similar to this: 

40000 MB Disk 0 at Id0 on bus 0 on …… 

 Partition1 (EISA Utilities)…… 

 Unpartitioned Space 

  Highlight the Unpartitioned Space and hit C 

NOTE:  If you get an error about no hard-drives found refer to the troubleshooting appendix about 
loading 3rd party drivers during setup 

7.  Create Partition of size – change the prepopulated value to 8192 and hit Enter 

8. Back at the partition selection screen highlight the partition you just created and then hit enter 

9. Format Partition Option – select Format the partition using the NTFS file system (Quick) and hit enter 

10. Formatting progress bar will appear – it should go pretty quickly 

11. A file copy progress bar will appear and copy the Windows Server files 

12. The system will confirm all files copied and reboot automatically – when it comes back up it will 
perform some further file copies and go into a more GUI based setup. 

13. The first GUI setup prompt is for the language and region options – Click Next 

14. Name and organization – type ASN IT into both fields and click Next 

15. Volume License Key – Enter the key found on the Serial Numbers CD in DR Media 1 and click Next 

16. Licensing Mode – Click Per Device or Per user Radio Button and then click Next 

17. Computer Name – Enter the name of the PS DB server from your DR server list   

18. Administrator Password – enter the admin password on the DR password list from the DR box and then 
click Next 

19. Date and Time Settings – set the correct date, time and Time Zone (Use Mountain Time Zone) and click 
Next 

20. Installing Network will appear on the left side of the screen with a progress bar.  When the progress 
bar is gone you will see the Network Settings Window – Click Next to continue (you will change these 
settings later after setup completes) 

21. Workgroup or Computer Domain screen – leave defaults and click Next 
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22. Now pretty much you get to sit and watch for about 20-30 minutes while setup completes.  Take a 
deep breath and go grab a soda or use the bathroom 

23. The server will reboot once all of the setup tasks are completed.  When it returns to the login prompt, 
log in to the server using the admin password you entered above from the DR password list 

24. Once the login is completed you will see the “Manage your Server” screen – you can close this and go 
to Start -> Control Panel -> Network Connections Right click on the network connections and choose 
Open from the menu 

25. Right click on the connection named Local Area Connection and click properties 

26. Click the Configure button 

27. Click the Advanced tab 

28. In the Property list you should see something equivalent to Link Speed/Duplex Mode or Media Type – 
click on it to highlight it 

29. In the drop down to the right choose the option that is closest to:  100 Full 

30. Click OK 

31. This will close the properties window - Right click on the connection named Local Area Connection and 
click properties again 

32. Highlight the Internet Protocol (TCP/IP) in the configuration menu, and then click the properties button 

33. The Properties window will open.  Click the radio button next to “Use the Following IP address” in the 
fields enter the following information: 

a. IP Address:  Enter your DR IP Address for the Server here  

b. Subnet Mask: Enter your subnet mask 

c. Default Gateway:  Enter your default gateway 

d. Preferred DNS Server: Enter DNS Server IP 

e. Secondary DNS Server:  If one is available you can enter it – otherwise leave blank 

34. Click the Advanced button at the bottom right 

35. Click the WINS tab 

36. Click the Add button, and in the Add Wins Server IP field, type in your WINS IP and click the Add Button 

37. Click OK to close the advanced settings 

38. Click OK to close the TCP/IP properties window 

39. Click the Checkbox next to “Show Icon in taskbar when connected” and then Click Close 

40. Click Start and right click on My Computer – choose Manage from the menu 

41. In the Computer Manager tree, find the section labeled Disk Management and click to highlight it 

42. In the Disk Management window you should see a Drive labeled Disk 0 with the words: (+/-) 350.00 
GB (essentially composed of everything left on the drive minus the 8 gig OS partition) and Unallocated 
next to it in a black outlined box – right click in the box area and choose Create Partition … from the 
menu 

43. Welcome screen – click Next 

44. Partition Type screen – click Next 

45. Specify Size – click Next 

46. Assign Drive Letter Change Drive Letter to S: – click Next 

47. Format Partition options: 

a. Change the Allocation Size from Default to 64k  
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b. In the volume label field, type:  SQL Data 

c. Click the check box next to “Perform a Quick Format” - then click Next 

48. Confirmation summary – click Finish 

49. The partition will format and display in the disk manager window 

50. Close the Computer Manager window 

NOTE – if the recovery of the Domain Controller is not complete then you must pause here before 
continuing.  Once the restoration of that server is done, reboot this server and continue from the next step. 

51. Back at the desktop – click on the start button and then right click on My Computer and choose 
Properties from the menu 

52. click the Computer Name tab 

53. click the Change button 

54. Click the radio button next to the word Domain and in the text field type in your domain name – click 
OK 

55. Enter password prompt – enter in the administrator name and password as:  
YOURDOMAIN\administrator and the password – click OK 

56. Domain confirmation – click OK 

57. You must reboot prompt – click OK 

58. System Properties – click OK to close 

59. System Settings Change prompt – click Yes to reboot 

60. Once you have logged back into the server as the domain admin account you are ready to install SQL 
2000 

 

Install SQL Server 2000 and SP 

NOTE:  at the time of this writing PSoft was only able to run on SQL SP3a – SQL Service pack installations are 
generally VERY uniform, but pretty much a Follow the Wizard” approach should cover any installation 

Install SQL Server 2000 

1. Locate the SQL 2000/Winzip CD from DR Media 2 

2. Once you have logged back into the server (make sure to log into the Domain and not just the local 
server – you can verify this by clicking the Options button at the login screen, and making sure the 
Archstone domain shows up instead of the computer name) – insert the CD and browse to the CDROM 
drive 

3. under the SQL2000 folder, drill down to the x86\setup directory and double click the setupsql.exe file 

4. SQL server setup prompt about compatibility – click Continue (you will patch after the install) 

5. Welcome – click next 

6. Computer Name – click Next 

7. Installation Selection -> click next 

8. User information – click next 

9. License agreement – click Yes 

10. Installation Definition – click Next 

11. Instance Name – click Next 

12. Setup Type – click the Browse button next to Data Files 
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13. Choose Folder box – Type in “S:\” and hit OK 

14. Back at the Setup Type Screen – Click the radio button next to Custom and then click Next 

15. Select Components screen – click Next 

16. Service Account – click the radio button for “Use Local System” – click Next 

17. Authentication Mode – click the radio button for Mixed Mode – in the sa password field enter the 
disaster recovery SA password from the password list 

18. Collation Settings: 

a. Click the radio button for Collation Designator: 

b. Under Sort Order, click the checkbox next to Binary 

c. Click Next 

19. Network Libraries – click Next 

20. Start Copying Files – Click Next 

21. Licensing Mode – click Processor License and change to match the number of processors in the system 
– then click Continue 

22. Setup will now run and copy files and start the SQL server 

23. When it is completed click Finish to exit 

 

Install SQL Server SP3a 

1. On the SQL 2000 CD browse to the root and double click the SQL2kSP3a file 

2. Installation folder prompt – click Finish  

3. Folder Does not exist – click Yes and the files will be unpacked 

4. Package delivered confirmation – click OK 

5. Back at the CD Rom drive root – browse to c:\sql2ksp3a\x86\setup and double click the setupsql.exe 
file 

6. Welcome Screen – click Next 

7. License Agreement – click Yes 

8. Instance name – Click Next 

9. Connect to Server – click Next 

10. Compatibility check list – click the check box next to Upgrade Microsoft Search and….. then click 
Continue 

11. Error Reporting – click OK 

12. Start Copying Files – Click Next 

13. When this portion is completed you will see a prompt to backup the master and msdb databases – 
click OK 

14. Setup Complete – click Finish 
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Install CommVault Agent and Restore Databases 

Install CommVault 

1. Insert the CD labeled CommVault Install Disk 1 into the server 

2. Language Selection – click Next 

3. Click the link that says – “install QiNetix Software on this computer” 

4. Welcome – click Next 

5. Anti virus prompt – click OK 

6. License Agreement – click the radio button for “I accept….” Then click Next 

7. Select Platforms – expand the iData Agents selections and click on the iDA for Windows Server 2003 

8. Expand the Database Agents – Select the check box for iDA for SQL Server  

9. Expand the Media Agents selection and click the Checkbox for Media Agent 

10. Click Next 

11. Installer rights prompt – click Yes 

12. Destination Folder – click Next 

13. CommServe Host Name – type in the name of your CommServe and hit Next 

14. Communication interface – hit Next 

15. Removable Storage Manager – Click Next 

16. Media Agent Index Cache Path – click Next 

17. Firewall Configuration – click Next 

18. Job Results path – click Next 

19. Summary – click Next 

20. Installer prompt – security rights – Click the Log Off button 

21. The system will log you off.  Log back in with the same account you used to start the setup – setup will 
resume 

22. Installation will process through and you will see the Configure drives and devices wizard prompt  Window 
title is cvmminst)– Click Yes 

23. Select Media Agents Screen – leave defaults and click OK 

24. SCSI device detection screen prompt (cvmminst is the window title) – Click OK 

25. SCSI Detection Screen confirmation again – click Yes 

26. Detect/Configure Devices – click OK 

27. Detection window will pass by rapidly 

28. Confirmation window for discovered device – Click OK 

29. Click Close on the Log window 

30. Library configuration manager screen may be minimized in the toolbar click on it to bring it to the front it will 
list the Attached libraries and drives.  For each library, right click and select “Configure” from the menu 

31. Confirmation prompt.  Click Yes 

32. The status bar at the bottom will say that the library configuration was completed - Click Start on the window 
and then click Exit 

33. Storage Policy selection – Use Previously assigned storage policies and click Next 
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34. MSSQL configuration Wizard – Highlight the SQL instance and click Configure 

35. Storage Policy Prompt – click Next 

36. Account name -> use the DR SQL backup Account from the DR password list – click Next 

37. SQL Undo Path – in the field type in S:\ and click Next 

38. SQL Config Wizard – click Next 

39. Prompt concerning databases – click Yes 

40. Confirmation of configuration - click Finish 

41. Permissions assigned prompt – click No 

42. Schedule Reminder – click Next 

43. Completion Report – click Finish 

44. Now, go to the CommCell Machine Console and log into the CommCell console 

45. In the CommCell Browser – highlight the client list header and hit F5 

46. Scroll down to the name of the SQL server you just installed and right click on it -> choose Install 
Updates from the menu 

47. You will see a notification of the installation beginning in the event viewer pane – when it tells you that 
installation is completed in the event pane you can proceed 

Restore Databases 

1. Back in the CommCell Console - Expand the: Policies –> Storage Policies section by clicking on the + 
signs 

2. Find the policy associated with your Peoplesoft DB server and click on it to highlight it 

3. In the right hand pane, right click on the copy called “tape” and choose All Tasks -> Migrate Media 
from the menu 

4. In the resulting media list, highlight all of the listed media and then click OK 

5. In the Migrate Media popup, choose the library you just configured on the recovery DB server from the 
list of libraries in the first drop down (there may be multiple “StandAlone” libraries – it will be the last 
one in the list) 

6. Choose the “Master Drive Pool” and “Drive Pool” in the next drop downs (there is only one option here 
so select it) and then click OK 

7. Barcode Media prompt – click OK 

8. A confirmation will popup after a few seconds – click Close 

9. In the CommCell Browser window, expand the client list and find your Peoplesoft DB server – expand it 
by clicking the + sign 

10. Right click on the SQL Server 2000 iDA and choose Browse SQL Instance from the menu 

11. In the Browse options window click OK 

12. Expand the tree to view the databases that are available 

13. Click the Checkbox next to the Peoplesoft databases: 

b. You should list them here for consistency! 

14. Click the Recover All selected button to bring up the restore options dialog window 

15. In the restore options dialog box, you need to check the boxes next to “Point in Time” and 
“Unconditionally overwrite existing databases or files” – then click Advanced 
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16. You will see a list of the databases and the associated files – in the list you need to change any paths 
that are not pointing to the S:\ drive by modifying the beginning of the path statement to make sure 
that all files point to the S:\ drive 

17. Click OK to close the advanced options 

18. Click OK to start the restore process 

19. Warning prompt – click OK 

NOTE  -  if prompted to insert a tape into the library find the tape and put it in the library 

20. The restore will run – when it is completed return to the ENGPPL04 server console 

 

Reconfigure Restored Databases 

Once the restoration completes you need to open SQL Enterprise Manager and perform some reconfiguration 
steps.  Follow the steps below to reconfigure Peoplesoft for system access. 

1. Log into the server with the DR admin account (if you have not already) 

2. Click on Start -> All Programs -> Microsoft SQL Server -> Enterprise Manager 

3. Expand out the tree until you see the folders under the “(local)” 

4. Click the +sign next to the databases folder to expand it 

5. Verify that there is a database listed that is the same as the ones you restored and that it is not 
showing any messages next to it 

NOTE:  If it has a status message see the section in Appendix A regarding troubleshooting database status 
issues 

6. Click on the database to highlight it – select Tools -> SQL Query Analyzer from the menu 

7. The Query Analyzer screen will open 

8. Connect to SQL Server dialog box 

a. In the SQL Server field type a period “.” 

b. Click the Radio button for use Windows authentication 

c. Click OK 

9. From the toolbar menu – click on the Folder icon 

10. the open SQL file browse dialog will appear – insert the Tools CD (if not already in the system) and 
browse to the CDROM drive -> \SQL Servers\Peoplesoft SQL Scripts 

11. Open the psusers.sql file by clicking on it and clicking OK 

12. The window will fill with SQL Query language – click the Green arrow on the menu bar to execute the 
query 

13. You will see a number of “(1 row affected)” messages go by very rapidly – when completed click on the 
folder icon again 

14. Click No at the Save changes prompt 

15. the open SQL file browse dialog will appear – insert the Tools CD (if not already in the system) and 
browse to the CDROM drive -> \SQL Servers\Peoplesoft SQL Scripts 

16. Open the grant.sql file by clicking on it and clicking OK 

17. The window will fill with SQL Query language – In the drop down on the upper right of the window it 
will say “master” in the field – click the drop down and select the Database that you restored that is 
the main Peoplesoft DB 
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18. Once you have chosen the Database from the list - click the Green arrow on the menu bar to execute 
the query 

19. You will see a number of “(1 row affected)” messages go by very rapidly – when completed click on the 
folder icon again 

20. Click No at the Save changes prompt 

21. the open SQL file browse dialog will appear – insert the Tools CD (if not already in the system) and 
browse to the CDROM drive -> \SQL Servers\Peoplesoft SQL Scripts 

22. Open the fixadmin.sql file by clicking on it and clicking OK 

23. The window will fill with SQL Query language – click the Green arrow on the menu bar to execute the 
query 

24. You will see a few “(1 row affected)” messages go by very rapidly – when completed click on the folder 
icon again 

25. Click No at the save changes prompt 

26. the open SQL file browse dialog will appear – insert the Tools CD (if not already in the system) and 
browse to the CDROM drive -> \SQL Servers\Peoplesoft SQL Scripts 

27. Open the grant.sql file by clicking on it and clicking OK 

28. The window will fill with SQL Query language – In the drop down on the upper right of the window it 
will say “master” in the field – click the drop down and select the Database that you restored that is 
the main Peoplesoft DB 

29. Once you have chosen the Database from the list - click the Green arrow on the menu bar to execute 
the query 

30. You will see a number of “(1 row affected)” messages go by very rapidly – when completed click on the 
folder icon again 

31. Click No at the save changes prompt 

32. the open SQL file browse dialog will appear – insert the Tools CD (if not already in the system) and 
browse to the CDROM drive -> \SQL Servers\Peoplesoft SQL Scripts 

33. Open the spconfig.sql file by clicking on it and clicking OK 

34. The window will fill with SQL Query language – click the Green arrow on the menu bar to execute the 
query 

35. Click the Messages tab at the bottom of the query window – you will see a number of messages that 
begin with “DBCC …”  The last entry should be “Configurations option ...” 

36. You can now exit the Query Analyzer by clicking the X in the upper right of the window 

37. Click No at the save changes prompt 

38. Back in the Enterprise manager screen – right click on the server “(local) (Windows NT)” and choose 
stop from the menu 

39. Are you sure prompt – click Yes 

40. Right click on it again and choose start from the menu 

41. Prompt about SQL does not exist – click OK 

42. Right click on the server name one more time and choose Connect from the menu 

43. Expand the server tree out and drill-down to Security -> Logins – click on the Logins section 

44. In the list on the right hand side find the user account called “people” (NOTE: this account is the 
default Peoplesoft account, but it may be different in your environment!) and right click on it – 
choose properties from the menu 

45. In the password field type in the Password from the DR password list – click the Database Access tab 
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46. Make sure that the checkbox next to your production Peoplesoft DB is checked (check it if not) – in the 
Permit in Database Role section at the bottom of this window – click the checkbox next to “db_owner” 

47. Click OK 

48. Password confirmation prompt – type in the same password from above – click OK 

49. Back at the user list – scroll down a little further to find “psoftsa” (NOTE: this account is the default 
Peoplesoft account, but it may be different in your environment!)  – right click on it and choose 
properties from the menu 

50. In the password field type in the Password from the DR password list – click the Server Roles tab 

51. Click the checkbox next to System Administrators 

52. Click the Database Access tab 

53. click the checkbox next to your production Peoplesoft DB (if not already checked) – click the checkbox 
next to “db_owner” 

54. Click OK 

55. Password confirmation prompt – retype the password from the DR list and click OK 

You are now ready to complete the configuration of your PSoft Application servers and boot the Peoplesoft 
Domain! 

NOTE – concerning Psoft application servers – if you imaged them from production the 
reconfiguration steps are fairly minimal. 
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Build the Console Server(s)  
 

These are optional builds for your environment, but having at least one admin point to work from aside 
from sharing a VM console on a singe server is a nice thing! 

 

Install Windows Server 2003 

Follow these steps to install Windows 2003 server on the console system server(s) identified in Step 3 

1. Insert the Windows Server 2003 CD into the server, and power on the machine 

2. The server will boot from the CD and begin Windows 2003 setup 

3. Eventually you will see a welcome to windows setup text screen with 3 options – Hit ENTER to continue 
with setup 

4. Windows Licensing Agreement screen – hit F8 to continue 

5. Partition selection screen – you should see something similar to this: 

40000 MB Disk 0 at Id0 on bus 0 on… 

 Partition1 (EISA Utilities)… 

 Unpartitioned Space 

 Highlight the Unpartitioned Space and hit C 

NOTE:  If you get an error about no hard-drives found refer to the troubleshooting appendix about 
loading 3rd party drivers during setup 

6. Create Partition of size – change the prepopulated value to 8192 and hit Enter 

7. Back at the partition selection screen highlight the partition you just created and then hit enter 

8. Format Partition Option – select Format the partition using the NTFS file system (Quick) and hit enter 

9. Formatting progress bar will appear – it should go pretty quickly 

10. A file copy progress bar will appear and copy the Windows Server files 

11. The system will confirm all files copied and reboot automatically – when it comes back up it will 
perform some further file copies and go into a more GUI based setup. 

12. The first GUI setup prompt is for the language and region options – Click Next 

13. Name and organization – type whatever you want into both fields and click Next 

14. Volume License Key – Enter the key found on the Serial Numbers List and click Next 

15. Licensing Mode – Click Per Device or Per user Radio Button and then click Next 

16. Computer Name – Enter the name of the server 

17. Administrator Password – enter the admin password on the DR password list from the DR box and then 
click Next 

18. Date and Time Settings – set the correct date, time and Time Zone (Use Mountain Time Zone) and click 
Next 

19. Installing Network will appear on the left side of the screen with a progress bar.  When the progress 
bar is gone you will see the Network Settings Window – Click Next to continue (you will change these 
settings later after setup completes) 

20. Workgroup or Computer Domain screen – leave defaults and click Next 

21. Now pretty much you get to sit and watch for about 20-30 minutes while setup completes 



Best Practices for Disaster Recovery (DR): Using CommVault QiNetix Software and VMware ESX Server Systems to Rebuild Following a Site-Level Disaster 

 
 

 

 
   

63

22. The server will reboot once all of the setup tasks are completed.  When it returns to the login prompt, 
log in to the server using the admin password you entered above from the DR password list 

23. Once the login is completed you will see the “Manage your Server” screen – you can close this and go 
to Start -> Control Panel -> Network Connections Right click on the network connections and choose 
Open from the menu 

24. Right click on the connection named Local Area Connection and click properties 

25. Click the Configure button 

26. Click the Advanced tab 

27. In the Property list you should see something equivalent to Link Speed/Duplex Mode or Media Type – 
click on it to highlight it 

28. In the drop down to the right choose the option that is closest to:  100 Full 

29. Click OK 

30. This will close the properties window - Right click on the connection named Local Area Connection and 
click properties again 

31. Highlight the Internet Protocol (TCP/IP) in the configuration menu, and then click the properties button 

32. The Properties window will open.  Click the radio button next to “Use the Following IP address” in the 
fields enter the following information: 

a. IP Address:  Enter your DR IP Address for the Server here  

b. Subnet Mask: Enter your subnet mask 

c. Default Gateway:  Enter your default gateway 

d. Preferred DNS Server: Enter DNS Server IP 

33. Secondary DNS Server:  If one is available you can enter it – otherwise leave blank 

34. Click the Advanced button at the bottom right 

35. Click the WINS tab 

36. Click the Add button, and in the Add Wins Server IP field, type in the WINS IP and click the Add Button 

37. Click OK to close the advanced settings 

38. Click OK to close the TCP/IP properties window 

39. Click the Checkbox next to “Show Icon in taskbar when connected” and then Click OK 

40. Back at the desktop click on Start -> and right click on My computer – select manage from the menu 

41. In the Computer Manager tree, find the section labeled Disk Management and click to highlight it 

42. In the Disk Management window you should see a Drive labeled Disk 0 with the words: (+/-) 350.00 
GB (essentially composed of everything left on the drive minus the 8 gig OS partition) and Unallocated 
next to it in a black outlined box – right click in the box area and choose Create Partition … from the 
menu 

43. Welcome screen – click Next 

44. Partition Type screen – click Next 

45. Specify Size – click Next 

46. Assign Drive Letter – Change to “S” and click Next 

47. Format Partition options: 

a. Change the Allocation Size from Default to 64k  

b. In the volume label field, type:  SQL Data 
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c. Click the check box next to “Perform a Quick Format” - then click Next 

48. Confirmation summary – click Finish 

49. The partition will format and display in the disk manager window 

50. Close the Computer Manager window 

NOTE – if the recovery of the Domain Controller is not complete then you must pause here before 
continuing.  Once the restoration of that server is done, reboot this server and continue from the next step. 

51. Back at the desktop – right click on My Computer and choose Properties from the menu 

52. click the Computer Name tab 

53. click the Change button 

54. Click the radio button next to the word Domain and in the text field type in your domain name – click 
OK 

55. Enter password prompt – enter in the administrator name and password as:  
YourDomainName\administrator and the password – click OK 

56. Domain confirmation – click OK 

57. You must reboot prompt – click OK 

58. System Properties – click OK to close 

59. System Settings Change prompt – click Yes to reboot 

60. Once the server is rebooted you are ready to install the console tools 

 

Install Management Consoles (exchange/SQL/CommVault/Etc..) 

Guess what?  Another section that is totally up to you to figure out!  Installation is easy for these tools – most of the MS 
stuff is an MMC snap-in.  CommVault’s Console installation is well documented as well. 
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Appendix A – Troubleshooting Steps  
 

Yet another “fill in your own blanks section”!  I put in some place holders to get you going – the rest is 
up to you! 

 

Connecting a CDROM drive to a VM Server 

How to connect a CD-ROM to a VM server 

 

Loading 3rd Party SCSI drivers during Windows Setup 

How to load using the F6 key 

 

Troubleshooting Database Status messages 

My database has a status of recovering or offline or suspect – now what? 

 

Troubleshooting Missing Shares 

No shares?  Now what? 

 

Restoring Databases without the SQL agent 

SQL Agent f_s up.  Now what?  Flat file restore. 
 
 




